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1. Introduction

Clinical Procedures (CP) is a new VistA package that provides features that can be used across
clinical departments, such as general medicine, cardiology, pulmonary, women’s health,
neurology, and rehabilitation medicine. CP is a conduit for passing patient results, using HL7
messaging, between the vendor and VistA. Patient test results are displayed in the Computerized
Patient Record System (CPRS). CP includes three modules, which are CP User, CP Manager,
and CP Gateway.

CP User is the primary application that clinicians use. For example, you can place an order for a
procedure, such as an EKG, through the Consults tab or Orders tab in CPRS, or Order Entry.
Then you can use CP User to check in a patient and initiate the actual procedure. If the procedure
is performed on a bi-directional instrument, the patient demographics are automatically
transmitted to the instrument. When the procedure is complete, the result is transmitted back to
VistA Imaging and attached to a TIU note/document that is associated with the original
procedure order.

If the procedure is performed on a uni-directional instrument, you use CP User to match the
instrument results to the requested procedure. The TIU note is created when the instrument
results are submitted to VistA Imaging. Standard Consults functionality is used to complete and
sign the TIU note. The main purpose of CP User is to link the results from the automated
instrument to the procedure ordered through Consults in CPRS.

System managers and clinical application coordinators use CP Manager. The main purpose of
this application is to add and edit automated instruments and procedures in the CP database. CP
Manager is also used to configure the site files and required system parameters.

CP Gateway manages the flow of information from the instrument interfaces to CPRS. CP
Gateway polls the system regularly for new data from instruments and processes this data into
usable attachments for the VistA Imaging system.

Topics discussed in this chapter are:

e Intended Audience
e Related Manuals
e Product Benefits

The following pages contain flowcharts explaining the bi-directional and uni-directional Clinical
Procedures process flow.
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Introduction

Intended Audience

This User Manual is intended for use by clinicians, physicians, nurses, technicians, TSO, and
IRMS. End users should be familiar with the following:

Windows operating systems
CPRS functionality

Related Manuals

Here is a list of related manuals that you may find helpful:

Clinical Procedures Installation Guide

Clinical Procedures Technical Manual and Package Security Guide
Clinical Procedures Implementation Guide

Clinical Procedures Release Notes

CPRS User Manual

Consult/Request Tracking User Manual

Consult/Request Tracking Technical Manual

Text Integration Utilities (T1U) Implementation Guide

Text Integration Utilities (T1U) User Manual

VistA Imaging System (Clinical) User Manual

You can locate these manuals in the VistA Documentation Library (VDL). Select Clinical from
the VDL web page, select the package you want, and then select the manuals. For example, you
can select CPRS on the left side of the page. The list of CPRS manuals is displayed.

Product Benefits

1-6

e Common User Interface

Clinicians can use CPRS to enter, review, interpret, and sign CP orders. CP documents
in TIU obey Authorization Subscription Utility (ASU) Business Rules. The update users
functionality currently used by Consults determines which users are allowed to access or
edit CP documents.

e Integration

Clinicians order procedures in CPRS. Orders are processed through the Consult/Request
Tracking Package (Consults) and data is interpreted, entered, and displayed through
CPRS. Final results of the CP procedure are displayed by VistA Imaging. Ordering,
viewing, reviewing, interpreting, and signing the CP medical record is accessed through
one location, the CPRS Consults tab. You use CP User to check in patients. CP User also
links the result from the automated instrument to the procedure ordered through Consults.

Clinical Procedures V. 1.0 April 2004
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e Variety of Accepted File Types
CP is able to accept data/final result report files from automated instruments. The
supported imaging file types are the following:

Axt  Text files

a1tf - Rich text files

Jpg  JPEG Images

Jjpeg JPEG Images

.bmp Bitmap Images

tiff  TIFF Graphics (group 3 and group 4 compressed and uncompressed types)
.pdf  Portable Document Format

html  Hypertext Markup Language

.DOC (Microsoft Word files) are not supported. Be sure to convert .doc files to .rtf or to
.pdf format.

e Links to Other Packages

CP interfaces with packages such as Computerized Patient Record System (CPRS),
Consult/Request Tracking package, Text Integration Utility package (TIU), and VistA
Imaging.

e Interface Between CP and Imaging

Certain images such as consent forms and report objects are acquired, processed, stored,
transmitted, and displayed by the VistA Imaging package. This interface between CP
and Imaging replaces the existing capture interface between Medicine 2.3 and VistA
Imaging.

e Inpatient and Outpatient Workloads

The Hospital Location, where the procedure is performed, is defined in the CP Definition
file (#702.01). The hospital location determines which Encounter Form is presented to
the end user. CPRS and TIU parameters allow for the configuration of TIU software to
display the electronic encounter form and prompt users to enter workload data. The data
is then passed to the Patient Care Encounter software (PCE) for inpatients and
outpatients.
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2. Working with CP User

This chapter describes how to get started with CP User.

Topics discussed in this chapter are:

Opening CP User

Defining CP User Icons

Selecting a Patient

Defining the Parts of the Main CP User Window

Opening CP User

With CP User, the result from the automated medical device is linked to the procedure that was
ordered through the Consults tab.

e Double-click CP User on your desktop. If you are not currently logged into the

VistA system, you need to enter your access and verify codes. Click OK. The main
CP User window is displayed.

Defining CP User Icons
Select View > Use Toolbar.
= Open Patient — Opens a new patient record.

* Refresh Patient - Refreshes the currently selected patient’s information.
s Check-in New Study - Checks-in a patient and opens a new study.

2 Open Study - Opens a currently selected study.

X Delete Study - Deletes a currently selected study.

i1 Help - Provides on-line help for this package.

2 Clinical Procedures Home Page - Goes to the Clinical Procedures Home Page on the Web.

April 2004 Clinical Procedures V. 1.0 2-1
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Selecting a Patient
1. Open CP User.

2. Select File > Open Patient. The main CP User screen lets you select a patient that has a
consult procedure ordered. You can choose Patient, Team, Clinic, or Ward.

- Choose Patient if you want to select a patient by name, complete SSN, or first initial
of the last name and the last four digits of the SSN.

- Choose Team if you want to select a patient from a specific team list defined in the
OE/RR List file (#100.21).

- Choose Clinic if you want to select a patient from selected clinic appointments for a
predetermined clinic and date.

- Choose Ward if you want to select a patient from selected MAS wards.

Confirm Patient Selection |

M ENER KENT.CLARK
Sew: MALE
Diate OF Birth: 1272541941 [60]
Social Secunty Humber: 444-66-9999
Service Connected?: YES
Type: SCYETERAN
Weteran [ /M) YES
Whard Location: 4A5
Roorn-Bed: 400-2
Cancel

Fig. 2-1

3. Double-click the patient’s name. A confirmation screen is displayed, which shows
additional information about the selected patient. See Figure 2-1. If you select a
sensitive patient, a sensitive patient window is displayed indicating that the patient’s
information should only be accessed on a need to know basis.

4. Click OK. Figure 2-2, the main CP User window is displayed.

2-2 Clinical Procedures V. 1.0 April 2004
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Defining the Parts of the Main CP User Window

In this main window, you can select a treating specialty from the left and view a list of

procedures within that treating specialty on the right. Click the column headers to sort them in

ascending or descending order.

Clinical Procedures =] E3
File  Wiew Help
000X 7HE
FEMT .CLARE. “Ward: 445 Rm: 400-2 6
444-66-3593 MALE DEC 25,1341 [B1] tillergies
Studies:
afdi':'":' 4 Procedurs | Check-ln D ate Time | Statusz | | nztrument <
el LM | [ Colonoscopy 7/11/01 #5544 M Complete
Hemaotalagy/Oncology (Y Colonoscopy 24801 1:02:14 PM Complete
Neurology [ Colonozcopy 8/8/01 1:24.08PM  Complete
Eﬁfrﬁg'rf';’ri (4 Calanascapy 8/17/01 95433 4M  Complate
Sipu [Spec Inpt Ptzd Unit) [ Colonoscopy B2 8517 A Errar |
[ Colonoscopy A2 203334 Complete
[ Colonoscopy 2M5/02 312454 Complete
(Y Colonoscopy 2/22/0211:56:04 Ak Complete
(Y Colonoscopy 4/25/02 22805 P Submitted
[ Colonoscopy 4/26/02 344454 Complete
[ Colonoscopy 4426/02 1180 P Mew
(Y Colonoscopy 4/26/02 12329 P Ready to Complete OLYMPIE
(Y Colonoscopy 3/5/02 3:50:19 Ak Error ZEMDOSC
(Y Colonoscopy a3/ 02 24874 P Error ZEMDOSC
[ Colonozcopy 39402 1:11:48 P Ready to Complete OLyMPUE
[ Colonoscopy IR0 248123 PM Complete ALy MPLE -
|User: GADDIE MARLIE [TECHMICAL WRITER) |Divizior: HIMES DEVELOFMEMT | o

Fig. 2-2

The status column displays New, Submitted, Error, Ready to Complete, Pending Instrument
Data, and Complete. Here is a description of each status type in (Fig. 2-2).

e New - (The New status is only available with VistA Imaging.) A study has been
requested by VistA Imaging and needs to be checked-in and submitted to an
instrument. Example: You scanned in a consent form through the VistA Imaging
Capture Workstation. A new CP Study record is created along with a TIU document.

April 2004
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2-4

Submitted - This study has been submitted to the VistA Imaging Background
Processor. The study report waits in the Imaging Background Processor queue to be
copied or processed and placed on the VistA Imaging server. A study in this status is
not accessible until VistA Imaging returns a status of Complete or Error and logs any
errors encountered in the submission process.

Error - This study has encountered an error while being submitted to VistA Imaging.
The error may have been caused when the TIU note was created, when a visit was
created, when the results were linked to the procedure, or when the attachments were
sent to the VistA Imaging server. Error messages are logged with the study and can
be reviewed by opening the study in an error status.

Complete - This study has successfully created a TIU note for interpretation and
images have been sent to VistA Imaging for the selected consult procedure order. If
any attachments were included, they have been successfully copied to the VistA
Imaging server.

Pending Instrument Data — (This status is only valid for bi-directional instruments
that have not returned results.) The procedure request has been submitted to a bi-
directional instrument and is waiting for the instrument to return the results. Studies
in this status should not be opened until the instrument has returned the results,
assigned them to the study, and marked the study as Ready to Complete.

- If the “Auto Submit to VistA Imaging” checkbox is selected for the associated
procedure in CP Manager, the study goes to Complete.

- If the “Auto Submit to VistA Imaging” checkbox is not selected for the associated
procedure in CP Manager, the study goes to Ready to Complete.

Ready to Complete —
When a study is done on a uni-directional instrument, the status displays as Ready to
Complete.

When a study is submitted to a bi-directional instrument, the study remains in
Pending Instrument Data status and changes to Ready to Complete after the study has
received the data from the instrument. (Auto Submit to VistA Imaging is not
selected.)

In the Ready to Complete status, you can open the study, view the Consult/Procedure
order, and manually submit instrument results and external attachments to VistA
Imaging.

Clinical Procedures V. 1.0 April 2004
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A study can be deleted when it has a status of “Pending Instrument Data” and the user has the
MD Manager key. A study should be deleted only if the study was sent to the wrong instrument,
or if the patient was unable to complete the procedure. Select File > Delete Study and click
Delete. A cancel order is sent to the device. If that device is not working, you must manually
delete the order from the device. Refer to the manual for your specific instrument for instructions
on deleting an order.
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3. Clinical Procedures Process, Part 1

This chapter describes the process to follow for ordering clinical procedures. (Although you can
order several types of procedures in CPRS, you must follow the steps in this chapter to order
clinical procedures.) This chapter uses the example of ordering a colonoscopy test to describe
the Clinical Procedures ordering process. Be sure to follow the required steps in sequential
order. You can do the optional steps as needed.

1. Order a consult procedure in CPRS. Required
2. Check in a new study. Required
3. Update study status to correct errors. Optional

Ordering a Consult Procedure in CPRS

This section describes how to order a CP procedure, such as a study, a test, or an invasive
intervention, such as a surgical or medical procedure, through CPRS. Keep in mind that you can
only order a Clinical Procedure as a procedure order and not as a consult request.

In addition to becoming familiar with the CPRS ordering process, you can learn about the
interpreter, which is the new user role within ASU that supports CP. The interpreter is a new
User Role created by ASU that defines a user who can interpret (sign-off or verify) the
procedure’s final report. Clinical application coordinators define interpreters in the Consults
package.

If you are an interpreter for a specific procedure, you can receive an alert when the procedure
results are ready for review. Additional comments can be added if necessary along with the
Procedure Summary code and the electronic signature. The following example describes how to
order a colonoscopy procedure through the CPRS Consults tab.

April 2004 Clinical Procedures V. 1.0 3-1
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1. Logonto CPRS. The Patient Selection window is displayed, Figure 3-1.

Patient Selection

Fatient List Patients
€ W Default IKent,EIarkI
" Praviders " Clinics " Tarel
(" Team/Perzonal  *#ards Keves Barton —I
" Specialties £ Al Kilmar, Buzz Kent. Clark
Kirk James T SSM: 444-66-3939
Kirow,Sergi DOB:  Dec 25,194
F.pugsley Lil
Lake,Spring Male
Landauer R olf eteran
Landa,Joseph B0% Service Connected
Lennan.Jahi _I
Lime, Harry Location: 445
Loveless Miguelita Foom-Bed: 4U1-2
Lo, Ll
Martinz Holly Save Patient List Settings
Matizze Henri
Maul.D arth
Memahon Yincent
Mdemplopes Disgruntied d|
Motifications
Info | P atient | | ocation | Urgency | Alert 0 ated/Time | teszane | Fomwards =
CAMUSEE ) [CBEBR]  [BAS] Maoderate  2003/01/17@10:38  Mew DC arder(s) placed.
CAMPBELL, [C4444) Moderate  2002/11/19@11:26  Completed Conzult ¥ PULMOMNARY
| ho patient n'a 2002A1119@7 056 Your tazk 330733 stopped becauze of an error
GOMERTOSE [G95...  [4A5] Moderate  2002/11/04@70:12  Hew DC order(z] placed. feoen
| PAINWHAT [PO9E7) Moderate  2002/04/17013:43  UNSIGWED COLONOSCOPY available for SIGMATURE. _ILI
4 3
Process Info | Frocess All | Eracess Eremave Fsard |
Fig. 3-1

2. Select a patient. Notice that Clark Kent is the selected patient. The Cover Sheet window

is displayed, Figure 3-2.
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&= ViztA CPRS in use by: Hood Marlie [DHCPSERYER1-9100-DEV-DEY)

File  Edit “iew Toolz Help

KENT.CLARK 4A5 400-2 Frirmary Care Team Llnassig; Eemate @ Postingz
444-66-3953 Dec 25,1947 [59] | Provider: HOOD MARLIE Aftending: Welby b arcus I [ata WA
Active Problems Allergies £ Adverze Reactions Fostingz
% Uterine Tumar-Antepartum K.ryptaonite Allergiesz
% Screen For Hypertenzion

Clirizal * arning Jan 06,00
% Tooth Devel/Emwp Diz Moz
% Benign Meoplasm Heart

Active Medications

Clinical Reminders
Mo active medications found

Due Date
Mo reminders due

Recent Lab Rezultz ikalz AppaintrentsMizitedAdmizsions

Mo orders found. T 98F Feb 03 |May 09,01 11:30 Cardiac Clinic |npatient

P24 Feb 03 |Sep 21,00 02:00 Prosthetics Cancelle
R 20 Feb 03
EP 185/140/1104pr
PM 33 Feb 03

\ Caver Shest 4 Problems gMeds 4 Orders ANotes 4 Consults AD/C Summ 4Labs AR eports /

Fig. 3-2

3. Click the Consults tab at the bottom of the window, Figure 3-3.
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&= ViztA CPRS in use by: Hood Marlie [DHCPSERYER1-9100-DEV-DEY)

File  Edit “iew Action Optionz Toolz Help
KENT.CLARK 4A5 400-2 Frirmary Care Team Llnassig; Eemate @ Postingz
444-66-3953 Dec 25,1947 [59] | Provider: HOOD MARLIE Aftending: Welby b arcus I [ata WA
All Consultz Aug 14,01 [=3] PULMOMARY FIUNCTION TEST PULMOMNARY Proc Conzu
E‘FE- All congults allCurrent Pat. Btatus: Inpatient |-
----- W Aug 1401 [c] PULMON Ward: 443

----- * 4ug 1301 [p] PROCED
----- % Aug 08,01 [c) COLONO
----- U1,
----- " Jul1o,m
----- " Jul 09,01
----- ¥ Jul 09,01
----- Ll N9 nt

(=] COLONOS
[pr] ELECTRO
[pr] ELECTRO
[c] UGl GAST

inl CATHFTFLT
[

Mew Congult

Mew Procedure

-- Related Documents

@ B Aug14.01 PFT [#865). C

|

i

Primary Eligibility:

Order Information

To Serwvice: PULMONARTY
Attention: ACKEPMAN MNIEN-CHIN
From Serwvice: dh5

Bequesting Provider: HOOD ,MARLIE

Serwice iz to be rendered on an INPATIENT basis

Place: EBedside
Tr oferucy: Boutine
Orderable Item: PULMOMNARY FUMCTION TEST
Procedure: PULMOMNARY FUMCTION TEST

Clinical Procedure:
Provisional Diagnosis:
Beason For Regquest:
Patient in acute asthma episode.

SPIROMETEY, PRE & POST
Lung Grarmaloma (515.)

COMPLETE
COMPLETE/UPDATE

Status:
Last Action:

RSP JE. Pamte Thomam = fMZo o

l |

SERVICE COMNNECTED t0% to 10C

% Cover Sheet 4Problems AMeds 4Orders gMotes g Consults 4D /C Surnm 4Labs 4 Reports /

Fig. 3-3

4. 1f you want to review an existing Consult or procedure, select one in the list from the
upper left panel. The lower left panel contains any supporting documents for the selected
consult or procedure, and the larger right panel contains the order details.

5. Click New Procedure on the left side of the Consults tab. You can also order a clinical
procedure from the Orders tab. Since Clark Kent is an inpatient, the Order a Procedure
window, Figure 3-5, is displayed. Go to step 7 to order the procedure.

(If you were to select an outpatient, Figure 3-4 displays so you can enter a location. Go to

step 6.)
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Location for Current Activities

Select the appointment ar vizit that zhould be
azzociated with the note or arders

Cancel |
Encounter Location

|< Select a location from the tabs below.... >

Clinic Appointments | Hozpital Admizzions Mew Yisit I

Wigit Lacation

n o =
2az -

2rd Added Far Mult _l ™ Historical Vigit: a wisit that
331 test J occurmed at zome time in
daz the pazt or at zome other
Eak Iu:u:e!ti-:un [pozzibly non-hh]
And's Audio Non-Count Clinic Bt iz ot LJSEE! far

Andp'S Audiclogy Count Clinic - workload credit.

Fig. 3-4

6. For Outpatients, select either the Clinic Appointments or New Visit tab.
- Select Clinic Appointments if the patient already has an appointment through
Scheduling.
- Select New Visit if an appointment has not been made through Scheduling, and then
select a location from the list of Visit Locations. The Encounter Location is filled in
automatically.
- If the patient had existing admissions, these are displayed under the Hospital
Admissions tab.
- Go to step 7 to order the procedure.

& Order a Procedure Ed

Procedure Iraency Attention

[cOL <COLONOSCOPY: =l |RoOUTINE =l Jachuft Keith F =l

Service to perform thiz procedure Patient will be seen as an: Place of Consultation

|54STROENTEROLDGY =] Inpatient ¢ Outpatient [BEDSIDE =l
Provigional Diagnosis

Reason for Request Iundifferentiated abdominal pain [Lewizon |

Loute abdominal pain.

COLOMOSCORY GASTROEMTEROLOGY Proc BEDSIDE - -
Accept Order [ Lt
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Fig. 3-5

7. To order the colonoscopy procedure, select Colonoscopy from the Procedure dropdown
list, Figure 3-5.

- Complete the appropriate fields.
- Click Accept Order.
- Click Quit.

8. To sign the consult procedures, select File > Review/Sign Changes. Figure 3-6 is
displayed.

- Click the appropriate check box to select the colonoscopy.
- Enter your electronic signature code.
- Click Sign to return to the Consults tab. At this point, the procedure order is completed.

Review / Sign Changes

Signature will be Applied to Checked ltems

Orders -

COLOMOSCORY GASTROEWNTEROLOGY Proc Congultant's Choice *UNSIGHED*
PULMOMARY FUMCTION TEST PULMOMARY Proc Consultant's Choice *UNSIGMED*

Electronic Signature Code

Sign I Cancel I

Fig. 3-6

9. Click the Orders tab to review the ordered procedures. These procedure orders appear
on the Active Orders sheet (Fig. 3-7).
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&= ViztA CPRS in use by: Hood Marlie [DHCPSERYER1-9100-DEV-DEY)

File Edit “iew Action Optionz Toolz Help

KEMT .CLARK 4A5 400-2 Frirmary Care Team Unaszsigr Hemote @ Poztingz
444-66-3393  Dec 25,1941 [59) | Provider: HOOD MARLIE Attending: welby b arcus I [ata WA
Order Shest Active Orderz (includes Pending & Recent Activity] - ALL SERVICES
Active Orders [incEs=LEE | Order | Start / Stop | Provider | Nrsl Elkl Chart
Adrmit... bRl OF HEAD Start; 09/10/99 Taylor,C -
Br_anﬁfer... Conzultz | GASTROEMTEROLOGY Conz Bedzide Start: 06/21/01 16:12 | Demoszs,C
------ S — PARACENTESIS Cons Bedside Start: 04/24/01 14:33 | Reznik.C
Wiite Orders Conzult DEMTAL, TEST Regad
Allergies Procedur| PULMOMARY FUMCTION TEST Start: 08/17/01 09:52 | Hood M
Criet PULMOMARY Proc Bedside
teds, Inpatient COLOMOSCOPY GASTROENTEROLOGY | Start 08/17/01 09:52 | Hood M
ked ‘:nllf'l:\:uhl:iﬂf » PTDC BEdSidE
EE'?'S;S PROCEDURE ENDOSCOPY Proc Bedside | Start 03/413/01 1653 AckemanN
Toerrn ELEEEIHEIEI%&HDIDGH&M CARDIOLOGY | Start 0710401 08:25 | Ackerman,M
roc Bedside

consul ELECTROCARDIOGRAM EKG ISC Proc | Start 07/03/01 11:08 AckermanN
Yitals Bedzide |
Text Only Order CATHETERIZATION CARDIOLOGY Start: 07/09/01 11:08 | Ackerman M

CLIMIC Proc Bedside

CATHETERIZATION CARDIOLOGY Start: 06/25/07 10:51 | Ackerman,M

CLIMIC Proc Bedside

PROCEDURE EMDOSCOPY Proc Bedzide | Start: 06/21/01 16:15 | Demoss,C

COLOWNOSCOPY GASTROEMTEROLOGY | Start: 06/06/01 13:43 | Ackermat,M

Proc Bedzide

PULMOMARY FUMCTION TEST Start: 06/06/07 13:40 | Ackerman,M

PULMOMARY Proc Bedside -

4 Cover Sheet AProblems 4Meds §Orders A Motes A Consults 4D/C Surm 4Labs 4Reparts /

| | | | [
Fig. 3-7
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Check in a new study

Checking in a new study is the next step in the Clinical Procedures process. You need to check in
a new study in CP User after a procedure has been ordered. (Keep in mind that the CP check-in
is not related to the Scheduling check-in process.)

If you want to link multiple results to one procedure, you can check in multiple studies for the
same procedure that you ordered through Consults. In this way, you do not have to order
multiple procedure requests. In this example, the colonoscopy procedure was ordered and a new
study for the colonoscopy procedure is being checked in.

1. To check in a new study, first logon to CP User and select the patient. Refer to Selecting
a Patient, 2-2.

2. Choose File > Check in New Study to check in the patient.

Clinical Procedures Check In x|
KEMT CLARE “Ward: 445 Rr: 400-2 6
444-66-3999 MALE DEC 25,1941 [E1) Allergies
Conzults:

Clinical Procedure | Date Ordered | IIrgencyStatus :I
Colonoscopy A320/2003 22354 P Routine/c
Colonoscopy 262003 3: 2235 AM Raoutine/p -
FParacentesiz 4,/24,/2001 2:33:31 PM Routine/p -
- o I _"I_I
" Mo lnstrument Cupatient Yizitz I Mew ".‘."igitl

= Use Instrument _ _
Location | D ate/Time | Status |

INPATIEMT APPOL...

31/2003 3:.00:00 ...

OLYMPUS Sigmoidoscopy

Check In Cancel

Fig. 3-8

3. Select a Consult procedure order for the selected patient. See Figure 3-8. The Clinical
Procedure column lists the consult procedure orders. Notice that the colonoscopy
procedure is selected.

Note: You can only select from Clinical Procedure request orders that are in the Pending
(p), Scheduled (s), Partial Results (pr), Complete (c), and Active (a) statuses.
Discontinue (d) and Cancel statuses are excluded.
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4. Depending on the consult procedure you selected, the appropriate instruments for that
procedure are displayed. Click the appropriate instrument if more than one is listed, or
click No Instrument if no instrument is associated with this procedure. OLYMPUS is
the appropriate instrument in this case and is selected.

5. You must associate each CP study with a PCE visit, which is the hospital location where
the procedure is performed. Required.

For the majority of TIU notes created through CP, the visit association is completed in
the background. If a visit has already been recorded but the note wasn’t linked
(standalone visits, such as telephone or walk-in visits), you can select a visit from the
Clinical Procedures Check In edit screen (Fig. 3-8).

To link the CP study to the visit, select information from the Outpatients Visits tab on
Figure 3-8. You can also select the New Visit tab and enter NOW for the date and time.

6. Click Check-In. The main CP User window, Figure 3-9, is displayed.

Chmical Procedures M= E3
File  “iew Help
=087 E
FEMT .CLARE. “Ward: 445 Rm: 400-2 0
444-66-3999 MALE DEC 25,1941 [B1] Billergies
Studies:
L ' £ Procedure | Check-ln D ate Time | Status | Instrument:l
[Edicine] [ Colonoscapy 4/26/02 11801 PM New
Hemotology/Oncology [ Colonozcopy 426/0271:2329 P Ready to Complete OLvMPUE
NEUT':'!':'Q.'r' [ Colonoscopy /5402 38019 Ak Errar SEMDOSE
Ei{;gﬁ;’ﬁ; [ Colonoscopy 8/7/0224814PM  Enor ZENDOSE
(Y Colonoscopy 3/9/02 1:17:48 P Ready to Complete OLYMPIE
[ Colonoscopy 2503 24813 P Complete OLYMPUE
[ Colonoscopy 32503 30357 P Pending Instrument Data  OLYMPUS
[ Colonoscopy B3 2446 8 Pending Instrument Data OLYMPUE
(Y Colonoscopy B/23/037:48:22 P Complete OLYMPIE
(Y Colonoscopy BAZ23/03 271212 PM Complete OLYMPIE
(Y Colonoscopy GB/2303 21354 P Errar OLY'MPUE
[ Endoscopy OF Bowel Pouch  B421201 4:02:21 PM Complete
(4 Endoscopy OF Bowel Pouch B/21401 415:39PM  Complete
[ Endoscopy OF Bowel Pouch  BA21/00 4:21:23PM Enor b
[ Endoscopy OF Bowel Pouch 8414201 11:41:03 &M Complete
[ Endoscopy OF Bowel Pouch 8414200 11:4234 AWM Complete

[T (N 1

o

i e A A E e L

— [

|User: GADDIE MARLIE [TECHWICAL WRITER) |Divigior: HIMES DEVELOFMEMT | o
Fig. 3-9
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7.

If the study is checked-in for an instrument with a uni-directional interface, the status is
Ready to Complete. If the study is checked-in for an instrument supported by a bi-
directional interface, the status is Pending Instrument Data. (Notice on Figure 3-9, the
colonoscopy status for 3/25 and 3/26 is Pending Instrument Data.)

At this point, the clinician performs the procedure on the instrument and transmits the
results back to VistA.

If the instrument is bi-directional and the Auto Submit to VistA Imaging checkbox is
selected for the procedure in CP Manager, the study status changes from Pending
Instrument Data to Complete. This occurs after the result has been transmitted to VistA,
matched to the study, and copied over to VistA Imaging successfully. The study is ready
for interpretation. At this time, the CP process is complete and attachments cannot be
associated with this study. See Clinical Procedures Process, Part 2.

If the instrument is uni-directional or if the instrument is bi-directional and the Auto
Submit to VistA Imaging checkbox is not selected, the study status is Ready to Complete.
Go to the next step (9) to manually complete the CP process.

Open the study (Figure 3-9) and add the instrument results and/or external attachments.
You can only open studies that have an Error, Complete, Ready to Complete, or New
status. When a study is in the Ready to Complete or New status, you can open the study
and finish entering any data that was missed. An example of missed data is an external
attachment that was not associated with the study.

- Open this study and add results and/or external attachments. Click Open Study or
select File > Open Study. Figure 3-10 is displayed.

- Click +Results to select and submit the result to Vista Imaging. Only results for
the patient and instrument used for the procedure are displayed. To select multiple
results, hold down the CTRL key. To select a range of results, highlight the initial
result, hold down the Shift key, and then click the last result, Figure 3-11.

- You can also click +Files (Figure 3-10) to add additional attachments from the
External Attachment Directory. If the External Attachment Directory has not been
defined for this procedure, the last directory that was accessed may be displayed.
You can browse for other attachments to link to the study.

Note: If the system parameter Allow Non-Instrument Attachments was not selected
in CP Manager, +Files does not appear on the Clinical Procedures Study screen, you
are not permitted to associate additional attachments with the procedure.

10. Submit the study. The images are copied to the RAID and the TIU document is created

3-10

and associated with the procedure order.
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Chinical Procedures Study M= E

File  “iew Attachments

KEMT CLARK. ‘ward: 445 Rm: 400-2 6
444-66-9339 MALE DEC 25,1341 [51] Allergies
CP Procedurs—— Attachment:
COLOMOSCORY Yuwasz-gidal 42wdhimanhexport 000000k, brop
“TIU Mate:
[% TIU Mote Title:
COLOMOSCORY
~Conzult;
Q, Mo. 1355
“Inztrumnent:
Fil
OLYMPUS P |
“Status: =+ Results
Ready to Complete
= Eeriaye

253 Submit | ok el

Fig. 3-10
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| Instrument Results

=10 x|

Study

| i DatedTime Performed |.-'-‘-.ttan::hment

F

I HBEES-47303
HB665-47303
5B8665-47303
5B8665-47036
HBEEE-47036
HBEER-47036
HBEES-40711
HBEES-40711
BEEE5-40711
HB665-35135
5B8665-35134
: HB8664-60639
i hiBEE4-E0E39

8/14/2007 17:05:17 Ak
8/14/2007 17:05:17 Ak
8/14/2007 11:05:17 A
8/14/2007 11:05:17 Ak
8142007 11:05:17 Ak
8/14/2007 11:05:17 Ak
8/14/2007 11:05:17 Ak
8142007 17:05:17 Ak
8/14/2007 17:05:17 Ak
8/14/2007 17:05:17 Ak
8/14/2007 11:05:17 A
8/13/2007 4:05:18 PM

8/13/2007 4:05:13 P

SsishrimagingsuploadsSS8EE5-47309-3 bt
Migh-imaginguploadsh000000c. brp
Sigh-imaginguploadsh 0000006 brp
Wigh-imagingwploadshbEEER-47096-3 bt
Wamaz-gidal 42wdhimanhexport 000000z brap
Wamaz-gidal 42wdhimanhexpart 0000006 brap
Sish-imaginguploadsSB8EE5-40711 -3 bt
Sawaz-gidal d2wdsmantexporty000000c brp
Swaz-gidal d2wdsimanserport 0000006 brp
Wigh-imaginguploadshbEEES-381 35-1 bt
Wigh-imagingwploadshbEEES-38134-1 tat
Wigh-imagingwploadshbEEE4-G0633-2 tat

Shalympus_imantaall siman'export 0000004 by«

| »

Fig. 3-11

11. From Figure 3-10, click the magnifying glass under TIU Note to view the TIU Note for
that study if it is available. The magnifying glass for the TIU document is unavailable if
the result has not been submitted to Vista imaging. Once the result is copied to Vista
Imaging, you can view the TIU document of the study before or after the interpretation

has been entered, Figure 3-12.

3-12
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TIU Note Display =]

TITLE: COLOMOSCORY
DATE OF NOTE: AUG 21, ZO001@0S:59:47 ENTEY DATE: AUG 21, Z001@08:59:47
ATTTHOR: EXF COSIGHNEER:
TRGEMCTY: STATUS: UNDICTATED

PROCEDTRE SUMMARY CODE:
LATE/TIME PERFORMED: AUG 14, Z001R@11:05:1

Cloze |

Fig. 3-12

12. From Figure 3-10, you can also click the magnifying glass under Consult to view the
Consult report for that study.
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Cunszult Dizplay [_ O]
DATE OF MOTE: ATUG 17, Z001@059:559:23 ENTREY DATE: AUG 17, 2001@09:59:23_:]
AUTHOR: GADDIE,MARLIE EXP COSICMEER:
TRGENCTY: STATUS: COMPLETED

PROCEDTRE STTMMARY CODE: MNormal
DATE/TIME PERFORMED: AUG 14, Z001@11:0&

MNormal colonoscopi.
fesy MARLIE HOOD

TECHMICAL WRITEER
Sigrned: 0371772001 10:07

AUTHOR & TITLE:
|DATE

I #: |ORGANIZATION:HINES DEVELOPMENT | REG #: |LOC: 445

I I | FM/ED: 400-
EENT, CLARE 5C VETERALNW CONSULTATION SHEET
ddd-E5-9399 lz/725/15341 Etandard Form 513 (Rewy 9-
445 ANT STREET
METROPOLIS ILLINOIS 52407 Phone: 1-200-PHONE-HOME

-
1| | 3
Cloze
Fig. 3-13

Updating study status to correct errors

If you open a study in the Error status and have the MD MANAGER key, the Update Study
Status window is displayed. You must have the MD Manager key to access the Update Study
Status menu option. See your clinical application coordinator or IRM for access to Update Study

Status.
You can use Update Study Status to change the status of any study. Be careful when changing
the status of a study. With Update Study Status, you can force a status change of a study if a
problem occurs that you cannot fix with the Open a Study option.

1. Select File > Update Study Status, Fig. 3-14.

2. Select the status you want to change and click OK.

3. After you change the status, choose File > Open a Study and click Submit to resubmit
the study.
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Update Study Status x|

Current Statuz:  Errar
b ezzages:

ERROR: 0 Imagez copied

&G 07, 200201 4:55:04
AUG 07, 200201 4:55:06
AUG 07, 200201 4:55:06
¢ |AUG 07, 200201 4:55:068
| UG 07, 200201 4:55:06

1 |

[MAGING Images Submitted -
IMAGIMNG ERROR: 0 Images copied
[MAGING Error copying s sh-imagingsCP
IMAGING  :File dossn't exist : WWzh-imag
IMAGIMG 1 Yistd Image Entry dElEtEd:fILI

3

—Mew Status:
= Mew " Complete
" Submitted {~ Ready to Caomplete
£ Ermar " Pending Instument Data
o |
Fig. 3-14
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4. Clinical Procedures Process, Part 2

This chapter describes the process to follow for completing clinical procedures. (This chapter
uses the example of completing a colonoscopy to describe the Clinical Procedures process.) Be
sure to follow the required steps in sequential order. You can do the optional steps as needed.

4. Complete the Procedure. Required
a. Enter an Interpretation into the TIU note. Required
b. Enter Encounter information. Required for workload counts
c. Sign off. Required
5. View Clinical Procedures results. Optional
6. Link consent forms and images to Clinical Procedures documents. Optional

Completing the Procedure
To complete the procedure, you need to enter the interpretation into the TIU note, enter

encounter information, and sign off. In this example, the colonoscopy study is being completed.

Entering the interpretation into the TIU Note

1. Logon to CPRS. The Patient Selection screen is displayed, Figure 4-1.
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Patient Selection
Patient List Patients

= I ket LI
™ Providers ™ Clinics Kant.Clark ﬂ Cancel |

¢~ Team/Personal € Wards
™ Specialties o+ Al

Adrmit,Patient

Armstrong By Jr

Attending,Patient

Attitude B ad

Backward Hugh

Bamey.Purple

Beckert,Hans

Biddle Micholas

Bird K. G

Bloggs Joe

Eop.B aby Save Patient List Settings
Borig llu
Bradlee,Benjamin
Brandmeier Jonathon

Eampbell,Soup ;I
Matificatiohz
Infol Patient | L ocation | Urgency | Alert D ated/Time | M eszage | Fomwarded E
9] 2003/09/ 221 0: 23 Procedure ready for interpretation
[BAS] Moderate  2003/01/17@10:38  Mew DC arder(z] placed.
GOMERTOSE [G8...  [4A5] Moderate  2002/11/04@10:12  Mew DC orderfz) placed.
PAINWHAT [PO987) Moderate  2002/04/17@13:43  UNSIGWED COLONOSCOPY available for SIGMATURE.
D'S0OM FRE [DERRE] I 2002/02/0802771:02  Procedure ready for interpretation
1] | i3
Process Infa | Frocess All | Frocess Remove Farward

Fig. 4-1

2. In the Notifications box at the bottom of the screen, patients are listed with “Procedure
ready for interpretation”.
- Click Process Info if you want to process an informational alert (see left column under
Notifications, Fig. 4-1).
- Click Process All if you want to process all of the items listed.
- Click Process if you want to process an item through the Consults tab.
- Click Remove if you want to remove an item from the list.
- Click Forward if you want to forward the item to another person.

As part of this example, the patient, Clark Kent, is selected. To view results through
Consults, click Process. The Consults tab is displayed.
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&) Vizth CPRS in uze by: Gaddie.Marlie [DHCPSERVER1-9100-DEY-DEY)

File Edit “iew Action Optionz Toolz Help
KEMT .CLARK 4A5 400-2 Frirmary Care Team Llnassig; HEmmnte @ Poztingz
444-66-9393  Dec 25,1941 [B0) | Provider: GADDIE MaARLIE Attending: welby b arcus I [ata CwfA
All Consultz Apr 26,02 [pr] COLOMOSCOPY GASTROENTEROLOGY Froc  Conzult #: 151!
Current Pat. Status: Inpatient 1=
[pr] COLOMO Ward: 4A%
..... " Feb2202 [c] COLOND:  [Primary Eligibilicy: SERVICE CONNECTED E0% to 1O
----- "?' Feb 22,02 [p] PULMOM, rder Tnf ]
..... . roer hiformatilon
1L_F8b22ﬂ2 [dd COLONC To Service: GASTROENTEROLOGY
""" f reb 2202 [p) PULMON. oo vson: ACHUFF ,EEITH F
""" 1?.F3b22ﬂ2 () COLOMO: From Serwvice: 448
----- W Feb11.02 [p) ELECTRI Bequesting Prowvider: GADDIE, MARLIE
----- W lan A1 07 ol FKGIETT:J Serwice iz to be rendered on an INPATIENT basis
‘I i r Place: EBedside -
Tr oferucy: Boutine
New Consul Orderahle Item: COLONOSCOPY
Mew Procedure Procedure: COLONOSCOPY
- Clinical Procedure: COLONOSCOPY

<]

Felated Documents
2 Apr 26,02 COLOMOSCOF
A

Provisional Diagnosis:
Beason For Regquest:
Aoute abdominal pain.

Inter-facility Information
This iz not an inter-facility consult recgquest.

M

TIATMTAT TITWNTTT Mo

oroo oo

undifferentiated abdominal pain

I o

<] |

il

b Cover Sheet

Problerns sMeds 4 Orders ANotes jConsults 40 /C Surnm ALabs 4R eports £

Fig.

4-2

Note the image and note document within the Related Documents window (Fig. 4-2).

The consult procedure now has a status of partial results (pr). The CP document has the TIU
note title.

3. Click the CP title in the Related Documents window. The CP document is displayed in
the right window, Fig. 4-3.
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&) Vizth CPRS in uze by: Gaddie.Marlie [DHCPSERVER1-9100-DEY-DEY)

File Edit %iew Action Optiohz

Tools

Help

KENT.CLARK

444669999 Dec 251941 [B0)

4A5 400-2
Provider: GADDIE MARLIE

]
Frirmary Care Team Unaszsigr Hemote
Attending: welby b arcus I [ata

Poztingz
CwiA

@

All Canzulks

&pr 2602 COLONOSCOPY [#156E). GI LAR.

Al conzulks

..... W Feb 2202 [c) COLOND:
..... % Feb 2202 (p) PULMON,
----- W Feb 2202 [dc) COLOMC
..... % Feb 2202 [p] PULMOMN,
..... ¥ Feb22,02 (p) COLOND:
..... W Feb11.02 [p) ELECTRI

e Congult

Y

% Apr 2602 (pr) COLOND

----- " lan M1 N2 Ioel FEG I“.iFILI
4| i [

Mew Procedure

<] |

26,02 COLOMOSCOR

TITLE:

DATE OF HOTE:
AUTTHOR:
URGENCT:

COLONOS
ALPE 26,

PROCEDURE STUMMARY COD

DATE/TIME PERFORMED: AUG 14,

1]

COPY
Z00zZ@E03:45:54 ENTRY DATE:
EXP COSIGNEER:

STATUS:

E:
E001@11:05:1

APR EZg8, 2002

UNDICTATED

Diagrozes; CAMDIDASIS OF T

HE INTESTIME [Prirnary)

Procedures: UGIENDO; D= 'wWAW0 COLLEC SPE

4 Cover Sheet AProblems dMeds 4Orders AMotes AConsults 4D /C Surm 4Labs 4Reparts /

Fig. 4-3

The Author is not defined, Figure 4-3. This note is automatically created when the instrument
result is sent and submitted and an author does not exist. The Interpreter who is interpreting the
result is the default Author. The status of the document is always UNDICTATED when the
results are ready for interpretation.

4. To select the results that you want to interpret, choose Action > Consult Results >
Complete/Update Results, Figure 4-4.
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File Edit View [[¥S[Rg) Optiors Tools Help

KENT.CLARK Mew... rn-2 Prirary Care Team Unassig; Hemate @ Poztings
444-66-3333 D ) GADDIE MARLIE Attending: welby M arcus I [Eta CwhA
—————————— LConzult Tracking... ¥
All Consults 261 [l mhl AkAcEOFyY GASTROENTEROLOGY Proc  Consult #: 15
E"E—E: All cons Complete/Update Results... atient -
..... + (] ke sddendunm.. .
..... * Feh 2207 [o) COLOMO: P2 » SERVICE COMNECTED 50% to lOC
i ‘ Sittach Med Fesult
----- i D Fi_e?ncnve :’I;Cdlir;.iane ;S:sjlts
----- % Feb 2202 [dc) COLONC 2: = PSS
----- % Feb22.02 [p] PULMON, il Charige Title... UFF,KEITH ¥
"""  Feb22.02 [p) COLOMO:  py Hefuad Bailerplate Tewt
----- ¥ Feb 11,02 () ELECTRI R ; ; DIE,MARLIE
----- & Jan 2107 ol FKGriFIﬂ g AddioSigratie Lt on an INPATIENT basis
Ll_r 4 P elete Wotes, side -
U1 Editfdte,. tine
How Conscl o gave e ithout Sgratine: ]
Mew Procedure P1 = ONOSCOPRY
= 75 FeloedD : £l St ONOSCOPY
----- elated Documents . . :
i i [dentitddditianal Signers i £ i d abdominal i
LB Apr 26,02 COLOMOSCOR R: = i g drisrentisce mmanat pain
ad Eomblete
Inter—-facility Information
Thi=s iz not an inter-facility consult recguest.
| | ﬂ .-.‘..I_...._. nammTar mmeree me | _,|_

Y\ Cover Sheet {Problems £Meds fOrders 4Notes ) Consults £0/C Surnm 4Labs 4R eports /
[ [

.

[
Fig. 4-4

Note: To interpret the result, select the Complete/Update Results option. The Enter Required
Fields dialog box is displayed, Figure 4-5. The interpreter’s name displays by default in the
Author field.
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& Enter Required Fields [ O]
Author:
|5 adldie. Marle =l

Frocedure Summary Code

Marmal j
Procedure Date/Time

I.-'l'-.pr 26.200209:00 _I Enter Later |

Fig. 4-5

5. Select the appropriate Procedure Summary Code from the list (Fig. 4-5). The
Procedure Summary Codes include Abnormal, Normal, Borderline, and Incomplete.

6. Enter a Procedure Date/Time. Depending on the instrument, the Procedure Date/Time
is passed in the HL7 message from the instrument. As the interpreter, you can accept the

default. If the instrument does not pass the Procedure Date/Time, the interpreter has to
enter a Procedure Date/Time.

The Procedure Summary Code and Procedure Date/Time are required fields for the initial
note that you are editing.

If you close the Enter Required Fields dialog box without entering the requested information,
CPRS prompts the interpreter again.

Any subsequent note created on the same procedure after this initial note does not require the

Procedure Summary Code and Procedure Date/Time fields. The fields are optional on
subsequent notes.
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&= ViztA CPRS in uze by: Gaddie . Marlie [DHCPSERVER1-9100-DEY-DEY)

File  Edit “iew Action Optionz Toolz Help

KENT.CLARK 4A5 400-2 Frirmary Care Team Llnassig; Eemate @ Postingz
444-66-3993  Dec 25,1941 [60] | Provider: GADDIE MARLIE Aftending: Welby b arcus I [ata CwaA

&ll Consults COLOMOSCOFY Apr 26, 2002(E08: 45 Change...

E"'FEE: All conzults | Wab 02420402 GI LAE _I
4 I - ‘?- '&'plr Bz [pr] EDLDNP ~ Normal cnlnnnscDPY-l

Eng' Mote being edited
b Apr 26,02 COLOMOSCOFY

B Related Documents

<] | i

# Templates Diagrozes; CAMDIDASIS OF THE INTESTIME [Primary]
Procedures: UG EMDO; D WAWD COLLEC SPE

# Reminders

Encounter

% Cover Sheet 4Problems AMeds 4Orders gMotes g Consults 4D /C Surnm 4Labs 4 Reports /

Fig 4-6

7. Enter an interpretation in the space on the right side of the screen for the highlighted
(current) consult procedure (Fig. 4-6).
Entering Encounter Information
You can now enter encounter form information.

8. To enter the encounter information and complete the consult procedure, you must select
Action > Consult Results > Sign Note Now.

You can also select the Encounter drawer (Fig. 4-6) to directly enter encounter information.
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Mizzing Encounter Information |

@ WWiould you like b0 enter encounter infarmation now?

Fig. 4-7

This window (Fig. 4-7) asks if you want to enter encounter information now. (Fig. 4-7 is
displayed depending on how CPRS parameters are set. See the Implementation Guide for
information on defining CPRS parameters.)

9. Click Yes to enter encounter information, or click No to skip this step. If you choose No,
you can enter the information at a later time. In this example, the Yes button is clicked
and encounter information is entered.

Primary Encounter Provider [ x|

Are You, GADDIE . MARLIE . the Primary Provider for this

Encounter?
Select Primany |

Fig. 4-8

Figure 4-8 allows you to verify the primary provider for this encounter form.
10. Click Yes.

CPRS brings up the Encounter Form that was set up for the Hospital Location, where the
procedure was performed. The Visit Type tab is displayed.

11. Enter appropriate information for visit type. For example, in Figure 4-9, the following
information was entered:

Type of Visit. Established Patient
Section Name. Intermediate Exam 11-19 Min.
Visit Related to Service Connected Condition. Yes

Current providers for this encounter. Gaddie, Marlie
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&) Encounter Form for GI LAB [Feb 20_2002&09:00)
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=] E3
Yizit Type | Diaghozes I Procedures I Witals I |rrmnunizations I Skin Testz I Fatient Ed I Health Factors I E=amsz I
Type of izt Section Mame
N F'.-i'-.IEN . [] Brief Exam 1-6 Min 99211
L'--T'E"'” (] Limited Exam 510 Min 99212
Intermediate Exarn 11-13 Min 93213
[] Extended Exam  20-30 Min 95214
[] Comprehenzive Exam N+ Min 95215
Y'es Mo Yizit Related To
Service Connection & F ated Dizabilities

Semvice Connected: 505
PTERYGIU [10% M5SC)

Levailable providers

Faddie,Marlie

Drapaon,Rufino
Demozs,Carl E
Eichelberger Mancy L

Gohlinghaorst Sue Baco
Hickz Brent

[

Add

Remove |

Current providers for thiz encounter

GADDIE MARLIE

[

¥ I Service Connected Condition
T I &aenh Diatae Bxpasine

[0 [ ez Eeadistion Expastne

[ I Enviranmentall Cantanmimarts
e

I I Head andron W eck Earcer

Kreuz, Sher :
Krieg.Jean Fiimary |
Lang.Barbara Jean ;I 0k Camesl
Fig. 4-9
12. Click the Diagnoses tab.
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& Encounter Form For GI LAB [Feb 20_2002@09:00] [_ (O] x|

YWizit Type  Diagnoses | F'rl:nceduresl italz I Immunizatinnsl Skin Testsl F'atientEdI Health Factl:ursl E:-:amsl

Diagnozes Section

Section Mame

Problem List Items Calan TI_Jr|'||:|r-|_|n:E:pEeE:_ 239.0
ABDOMEN CavITy [] Calor Turnor-t alignant 153 9
BOWEL - LARGE [ Colan Pol 211 3
BOWEL - SMALL Sty -
HISTORY MALIGNANT TUMOR L] Crohn'S Disease 555 .9
IUPPER Gl [ Diverticulitiz OF Calar AE2.11
[] Diverticulosis OF Calan BE2 .10
[[] Rectal Bleeding 5E69.3
[] % ascular Inzuff Intesting BAY .9
[ Ulzerative Calitiz BEE .9
] Wabvulusz OF Intesting BE0.2
Other Diagnosis. . |
Add to PL | Primary | Selected Diaﬁnuses |
Frirnar CAMDIDASIS OF THE IMTESTIME [ Gddto
Secondary  Colon Tumor-Unspec. Froblem list

Prirmany |
Comments Select &1l |
I Remove |
ak I Cancel |
Fig. 4-10
13. Enter appropriate information for diagnoses. See Figure 4-10.
14. Click the Procedures tab.
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& Encounter Form for GI LAB [Feb 20_2002{@09:00) M=l E
Yizit Type I Diagnoses  Procedures | italz I [rmunizations I Skin Testz I Patient Ed I Health Factors I Exams I
Frocedure Section Section Mame b odifiers for Colorectal zcrm; ki gk ind
Gl FROCEDLIRE S Colorectal scrn; ki risk ind  GOT05 [T Claim Submitted 'with & wiitten Statement OF Intent
COLOMOSCOPY [] Calon ca som; barium enema GM Diztinct Procedural Service
[ Colon ca zcm; barium enema G| | Item Or Service Provided A Foutine Care In A Mec
[ COLOMOSCOPY FLEX; D (SEP PR || Locum Tenens Md Service (]
[ Md Predg Sve n Bural Hpsa (B
[ Medically Meceszary Service Or Supply  SC
[ Physician, Team Member Swe Ak
[ Procedure Code Change CC
] Resident/T eaching Phys Serv GC
] Subst Md 5ve, Recip Bill 15
[ ' aiver OF Liability O File G
Other Procedure. ..
[luantity | Seleted Procedures |

LGI EMDO; D W 0 COLLEC SPE Quantity

Colarectal scra; hi rizk ind - Digtinct Procedural Service

Comments Select &1l |
I Remove |

ak I Cancel |

Fig. 4-11
15. Enter appropriate procedure information. See Figure 4-11.

16. Click the Exams tab.
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& Encounter Form for GI LAB (Feb 20.2002&09:00) Mi=] E3
izt Typel Diagnnsesl F'rl:nceduresl Vitals I Immunizatinnsl Skin Testsl F'atientEdI Health Factars  Exams |

Exam Section Section Mame

Other Exanm...

Selected Exams

M arrinal ABDCOMEMN Exam

Results

I ormal -

Comments Select &l |

I Remove |

ak I Cancel |

Fig. 4-12

17. Enter appropriate exam information. (See Fig. 4-12.) Click OK to return to the Consults
tab.

Signing Off

18. To complete the consult procedure, select Action > Consult Results > Sign Note Now.

Apr 2602 COLOMOSCOPY [H156E). GI LAR, MARLIE GADDIE

Signature Code

I"’“‘""ﬂ k., I Cancel |

Fig. 4-13

19. Enter your electronic signature to sign the TIU note and complete the consult procedure.
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20. Click OK.

&= ViztA CPRS in uze by: Gaddie . Marlie [DHCPSERVER1-9100-DEY-DEY)

File  Edit “iew Action Optionz Toolz Help

KENT.CLARK 4A5 400-2 Frirmary Care Team Llnassig; Eemate @ Postingz
444-66-3993  Dec 25,1941 [60] | Provider: GADDIE MARLIE Aftending: Welby b arcus I [ata CwaA
All Consultz Apr 2602 COLOMOSCORY (#1566, GI LAR, MARLIE GADDIE
=-f Al consults - TITLE: COLONOSCOPY
% Apr 26,02 [c] COLONOS | |DATE OF NOTE: APR 26, 2002@08:45:54 ENTRY DATE: APR 26, 2002
..... % Feh22,02 [c) COLOND! AUTHOR: GADDIE,MARLIE EXP COSIGHER:
_____ 1%!' Feb 2202 [p] PULKON. TRGZENCY : STATUS: COMPLETELD

..... " Feb 22,02 [dc) COLONC
..... % Feb 2202 [p] PULMOMN,
..... " Feb22,02 (p) COLOND:
----- % Feb11.02 [pr) ELECTRI  IWormal colonoscopy.

-----  lan 21 N2 (nel FEG CART
4| i r fes;/ MADLIE GADDIE

TECHNICAL WEITER
Sigmned: D4/267200E 09:z8

PROCEDURE SUMMARY CODE: MNormal
DATESTIME PERFORMELD: APR zZ&, E00Z@09:00

Mew Congult

Mew Procedure

Apr 26,02 COLOMOSCOS

1| | 0

ESTAELISHED PATIEMT Intermediate Exam 11-19 Min

Diagnozes; CAMDIDASIS OF THE INTESTIME [Primary], Colon Tumar-Unzpec.
Procedures: UGIENDO; D= w0 COLLEC SPE, Colorectal zcm; i rizk ind - Distinct
1] | _*I Frocedural Service

% Cover Sheet 4Problems AMeds 4Orders gMotes g Consults 4D /C Surnm 4Labs 4 Reports /

Fig. 4-14

e The consult procedure now has a status of complete (Fig. 4-14).
e The procedure location (GI LAB in Fig. 4-14) is used for workload reporting.

e The workload for the procedure goes through the standard TIU interface with PCE
(Patient Care Encounter).

Even though the consult is complete, you can still attach additional files and studies to the same
order.
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Viewing Clinical Procedures Results

You can go to VistA Imaging to view results. If you as the interpreter did not interpret the result
right after the procedure was performed, you may want to view the results before you enter an
interpretation. In the colonoscopy example, the interpretation was entered in Fig. 4-6.

1. Logon to CPRS.

2. Select Tools > VistA Imaging Display, Fig. 4-15. The patient’s Abstract list is
displayed, Fig. 4-16.

File Edit “iew Action Options

KENT.CLARK ‘ , Imaging Display Primary Care Team Unassig; Hemate ) Postings
444-66-9993  Dec 25,1941 (60] | | Vista Imaging Capture Aftending: welby kM arcus I [Vata CwfA
Al Consults Lah Test Infarmation. . COLOMOSCOPY GASTROEMTEROLOGY Proc Consult #: 15
-1 Al consults Olpticrs. . ER Inpatient =
..... [pr] COLOND =T 45
..... " Feh2202 [¢) COLOND:  |Primary Eligibility: SERVICE COMNECTED 50% to lOC

----- ™ Feb 2202 [p) PULMON, order Inf s
_____ b L raer nrormatlon
..... "!;P EEE gggg ES]C]F'EE:;‘IEII]P:‘J[ To Service: GASTROENTEROLOGY

ittention: ACHUFF ,KEITH F
""" ‘?. Feb 2202 [p] COLOMO: From Serwvice: 445
----- " Feb11.02 () ELECTAl  |Requesting Prowider:  GADDIE,MARLIE

----- W an MNP (el FERTAFT ) |2ervice iz to be rendered on an INPATIENT basis
{I i 3

Place: Bedside o
Ur oerncy: Boutine
e Gl Orderahle Item: COLONOSCORY
Mew Procedure Procedure: COLOMOSCORY
= Clinical Procedure: COLONOSCORT

-t Related Documents

‘@ B Apr 26,02 COLONDSCOF

Provizional Diagnosis: undifferentiated abdominal pain
Reason For Request:
Acute abdominal pain.

Inter—-facility Information
Thi=s iz not an inter-facility consult recguest.

N | Cl TI_-____ nnnnnnnnnnnnnnn | _PIL

Y\ Cover Sheet {Problems £Meds fOrders 4Notes ) Consults £0/C Surnm 4Labs 4R eports /
[ [

.

[
Fig. 4-15
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% 24 of 3166 Abstracts : KENT . CLARK =]
| =X | i;;l %l
[ECICHESCOEoeiesE] COLONOECORT 020 DEORONOSCORNGHAE]  COLONOSCORT Oa4izt ﬂ
Error [0 ASCH Text ASCIH Text ASCH Text
Connucling i : :
n i

Imare 5eru‘er

UPFPER Gl
Error
Cunnuclin
tn g
Imare Server

ASCH Text

ASCI

document

COLOMNOSCOPY OTMIGf20

document

E ENDOECOPY OF BOWEL T ENDOZCORY OF BOWEL | & EMDOECOPY OF EOWEL
UPPER Gl 03M14/2001

document

13 COLOMOECOPY image 1¢ 14 SMALL EOWEL ENDOEC 15 ECG image 1 out of 1
UPPER GI OTM0E/2001

O&M42001

document

1 CARDIAC CATHETERIZA 12ECG image 1 out of 1
ECHO 07M&/200

ASCII Text

| Text

document

UFPER Gl 0&H4/2001
ASCIH Text

document

ECG 07052001

document

Acrobat

document

ECG OTHIF2001
Acrobat

document

16 ZRIROMETRY, PRE PO
PFT 0G6/21/2001

Fig. 4-16

Note: VistA Imaging accepts procedure results in .bmp, jpg, jpeg, html, .pdf, .rft, tiff, and .txt

formats.

1. Select View > Clinical Procedures to view Clinical Procedures document titles. The list
of CP documents for the patient is displayed. (Fig. 4-17).

Fil= Optionz Beports

Syzstem Manager

% Imaging [CP prototype] : KENT.CLARK ([DHCPSERVER1-9100-DEV-D.

Help

- M=l E3

Image List...
Abstracts...
Patient: KEN| Eoupiredam...

HEE Images

Badiology Exans...

isting : KENT. CLARK

gSla

Radiology Exams: KENT,CLARK

v Toolbar - Main

24 WS ToolBar - Abstracts

-\|e\||“|@|

Rich Text (RTF}

document

2 COLONOSCOPY image 12
COLOMOSCOPY 0211120

ASCI Text

Iran e Sener

Connectin
i H
Imange SReRT .

ASCH Text ASCIN Tewt

document

& ENDOSCOPY OF BOWEL
UPPER Gl 0&H14/2001
K- F\-

2 Progress Motes Signed

gl 8«

¥ )
P —
AR =i
~ITIU Document Listing
Options  Wiew
Errar
Cnnncctln i ﬁ

Imﬁgp Server -
3 Title I Date | Auithor
_ CRISIS MOTE 09/18/2001  MWIEM-CHIM ACKERRMA]
ASCH Text CLINICAL WARMING 01408/2000  MIEW-CHIM ACKERRMA
document

TEMDOSCOPY OF BOWELI £
UFPER Gl 03M14/2001

ASCIH Text

document

M CARDIAC CATHETERIZA 1
ECHO 07M&/2001

ASCH Text

Fig. 4-17
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% Clinical Procedures: KENT,CLARK

Optionzs  Wiew

SIEIERERGIE

‘H_—iiv ical Procedures Signed
Tit | Date

| ALthar | CoLnt

COLOMOSCORY
FFT
COLOMOSCORY

02/22/2002
03/13/200
084 742001

MIEM-CHIM ACKERMAN
MNIEM-CHIM ACKERMAM
MARLIE GADDIE

1
]
1
FFT 0314/2001  MARLIE GADDIE 1
COLOMOSCORY 02/08/2001  CHARMAIME REZMIE ]
COLOMBDSCORY 0712001 WIEM-CHIM ACKERMAMN 1
CARDIOLOGY MOTE 07/03/2001  MIEM-CHIM ACKERMAMN ]
IIFPER &I 07/03/2001  MIEM-CHIM ACKERMAM 1
PFT 07/03/2001  MIEM-CHIM ACKERMAMN 1
PFT 06/21/2001  MWIEM-CHIM ACKERMAMN 1
FROCEDURE HOTE 05/03/2001  MIEM-CHIM ACKERMAMN 1
I \ Y
Fig. 4-18 \

2. Click a document title, and then click the camera icon to display the associated images
for that CP document, Figure 4-18.

4-16

Clinical Procedures V. 1.0
User Manual

April 2004



Clinical Procedures Process, Part 2

% TIU Document, Images -- KENT . CLARK

ENEMER

KENT,CLARK COLOHOSCOPY Aug 17, 2001309:59:23 2 Images

document

1 COLONOSCOPY image 1 out] 2 COLOMOSCOPY image 2 an
COLONOSCOPY 05M4/200 COLONOSCOPY 0&M14/200

Fig. 4-19
3. Double-click the abstract to open the result file, (Fig. 4-19)

4. In the screen where the CP documents are listed, Figure 4-18, click the CP title, and then
click the report icon next to the camera. The TIU Note is displayed, Fig. 4-20.
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& COLOMOSCOPY 08/17/2001 KEMT. CLARK (K9999) Auth: MARLIE GADDIE

File
COLONOSCOPY 08/17/2001 KENT, CLARK (K9999) Auth: MARLIE GADDIE |
TITLE: COLONOSCOEY N
DATE OF WOTE: AUG 17, 2001@09:59:23 ENTREY DATE: AUG 17, 2001@09:59:23
AUTHOR: GADDIE. MARLIE EXP COSIGHER:
URGENCY : STATUS: COMPLETED

PROCEDUEE SUMMARY CODE: Normal
DATE-TIME FPERFORMED: AUG 14, 2001@11:05

Hormal colonoscopy.
se=s MARLIE HOOD

TECHHICAL WRITER
Signed: 08-17-2001 10:07

Al

b 4

Fig. 4-20

Fig. 4-20 is an example of a document that has been interpreted and signed.

If you launch Imaging Display before the document is interpreted, the Author field is undefined
and the status is UNDICTATED. Some users may want to view the results before interpreting.
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Linking Consent Forms and Images to CP Documents

As the interpreter, you can link a consent form or other images to CP documents by using VistA
Imaging Capture. VistA Imaging Capture software can capture clinical images or scanned
documents and attach them to Clinical Procedures. Refer to the VistA Imaging 3.0 MAG*3.0*7

Patch Document at the following website:

http://vaww.va.gov/imaging/3.0patches.htm

April 2004 Clinical Procedures V. 1.0 4-19
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|5.  :Viewing the Reports

After installing the Medicine patch MC*2.3*39 and the Clinical Procedures (CP) patch
MD*1.0*2, you can view the CP interpretations, which are TIU documents, along with Medicine
reports on the Computerized Patient Record System (CPRS) Reports tab.

Four changes are introduced with patches MC*2.3*39 and MD*1*2.

e On the CPRS Reports tab the Medicine folder has been renamed Medicine/CP.

e The CP procedure interpretations have been added to the list of Medicine procedures for
viewing and displaying on the CPRS Reports tab.

0 Only completed and signed CP procedures are displayed for CP reports.

0 Unless you are a Subspecialty or a Manager key holder within the Medicine
package, only released and verified Medicine procedures are displayed for
Medicine reports. However, if the View All field for a specific procedure in the
Procedure/Subspecialty (#697.2) file is set to Yes, then all Medicine procedures
of that type display.

o If you are a Subspecialty key holder within the Medicine package you can view
all statuses of Medicine procedures for that subspecialty.

o If you are a Manager key holder within the Medicine package you can view all
statuses of Medicine procedures.

e The Medicine View file (#690.2) controls which fields are displayed in the Medicine
reports except for the PFT reports. Because of the numerous background calculations in
the PFT report, this report remains unchanged.

e You can configure the Medicine Report to display in CPRS. See Configuring the
Medicine Report to Display in CPRS.

The difference between a Medicine Report and a CP Report is that all CP interpretations have a
consult number associated with them. The interpretation is the TIU document. Medicine reports
may have a consult procedure request number depending on whether the report was associated
with a consult request or not. Another difference is that the Medicine report displays the discrete
data entered through the Medicine package.

You can print these reports by first viewing the report, opening the File menu and clicking Print.
Then select a Windows printer to print the report.

The Abnormal, Full Captioned, Full Report, Procedures (local only) and Procedures reports
display a message at the end of each procedure, which indicates if there are images associated
with that procedure. The text is as follows:

NOTE: Images are associated with this procedure.
Please use Imaging Display to view the images.

¥ patch MD*1*2 July 2004 Viewing the Reports chapter added.
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After installing MD*1.0*2, your Medicine/CP folder will look similar to the following. (Click
on a report to view the new format):

Clinical Reports
Medicine/CP
Abnormal

Brief Report
Full Captioned

Full Report
Procedures (local only)

Procedures

Some of these reports are also located under the Health Summary folder:
Health Summary
Adhoc Report

Medicine Abnormal Brief [MEDA]
Medicine Brief Report [MEDB]
Medicine Full Captioned [MEDC]
Medicine Full Report [MEDF]
Medicine Summary [MEDS] - This is a listing of procedure headings that fall within
a specified date range.

The Procedures (local only) report can also be found under the list of Available Reports.

5-2 Clinical Procedures V. 1.0 April 2004
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Abnormal

This report shows all Medicine and CP interpretations that have a Procedure Summary Code of
Abnormal. The name of the report, selected date range and maximum number of occurrences
(Max/site) appear above the report.

Medicine/CP Abnormal [From: May 4,2003 to May 3,2004] Max/site: 10

Printed for data from 05/04/2003 to 05/03/2004 05/03/2004 13:16
“““““““““““ CONFIDENTIAL SUMMARY pg- 1 falaialalel
TEST,PATIENT 125-43-2111 3AS DOB: 02/03/1943

————————————————————————————— MEDA - Med Abnormal ---——-—-————————

APPOINTMENT DATE/TIME: 4/16/04@15:38
MEDICAL PATIENT: TEST,PATIENT
PROTOCOL: STOMACH TEST

EGD SIMPLE PRIMARY EXAM: Y

LAB OR XRAY: LAB

OCCULT BLOOD:

SPECIMEN COLLECTION:

INDICATION COMMENT: TESTING

LOCATION EVALUATED:
COLON ASCENDING
GROSS: ABSENCE
MEASUREMENT :
IMPRESSION:
FELLOW:
SUMMARY : ABNORMAL
PRIMARY DIAGNOSIS:
PROCEDURE SUMMARY : TESTING THE PROCEDURE

INSTRUMENT:
SCOPE 1
ENDOSCOPIST: DEMO,CP
WHERE PERFORMED:
WARD/CLINIC: Gl LAB
TIME STARTED: 0600
TIME COMPLETED: 1000
URGENCY OF PROCEDURE: ELECTIVE
PREPARATION DIET: CLEAR LIQUIDS
DIET COMMENT:
ENEMAS: PHOSPHASODA
COMMON BILE DUCT SIZE (mm):
PANCREATIC DUCT SIZE (mm):
DEPTH OF INSERTION:
POST-PROC INSTRUMENT CLEANSING:
SECOND FELLOW:

INSTRUCTIONS TO PATIENT:
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SEX: M AGE: 61 90 in/160 Ib AMBIENT: 35C/600T
RACE: WHITE, NOT OF HISPANIC ORIGIN TECH: SMITH,JOE
SMOKER CURRENT BRONCHODILATOR USE EFFORT:- GOOD
CONSULT DX:

COUGH

ASTHMA

INTERSTITIAL LUNG DISEASE

UNITS PRED ACTUAL %PRED  PREV1 PREV2  CI
VOLUMES - - -« e e e e e e e e e e e e e e e e e e e e e e e e e e e

INERT GAS DILUTION 6/30/03  6/6/02
(NOTES): TEST INERT GAS

TLC L 10.53 9.00 85.5 5.00 8.00 9.09

VC L 7.76 3.00 38.7 7.00 7.00

FRC L 4.38 4.00 91.4 3.00 6.50 U 5.42

RV L 2.80 5.00 178.3 4.00 4.00 U 3.68

RV/TLC % 56

BODY BOX 6/30/03  6/6/02
(NOTES): TEST BODY BOX

TLC L 10.53 3.00 28.5 7.00 9.90 9.09

VC L 7.76 2.00 25.8 6.00 7.00

FRC L 4.38 4.00 91.4 4.00 6.00 U 5.42

RV L 2.80 5.00 178.3 2.00 5.00 U 3.68

RV/TLC % 167

NITROGEN WASH OUT 6/6/02  5/31/02
(NOTES): TEST NITROGEN WASH OUT

TLC L 10.53 7.00 66.5 6.00 7.00 9.09

VC L 7.76 4.00 51.5 5.50 6.00

FRC L 4.38 3.00 68.6 4.00 4.00 U 5.42

RV L 2.80 2.00 71.3 3.00 3.00 U 3.68

RV/TLC % 29

X-RAY PLANIMETRY 6/6/02  5/30/02
(NOTES): TEST X-RAY

TLC L 10.53 5.00 47.5 7.00 9.00 9.09

VC L 7.76 4.00 51.5 6.40 6.00

FRC L 4.38 7.00 160.0 3.00 4.00 U 5.42

RV L 2.80 8.00 285.2 1.00 5.00 U 3.68

RV/TLC % 160

UNITS PRED ACTUAL %PRED  PREV1 PREV2  CI

FLOWS - - e e e e e e e e e e e e e e e e e e e e e e e e

MACHINE: FLOW TURBINE

STANDARD STUDY 6/6/02 5/30/02

(NOTES): TEST STANDARD
FVC L 7.76 4_.30 55.4 8.00 9.00
FEV1 L 5.79 2.20 38.0 6.00 4_.00 4.94
PF L/SEC 10.986 3.200 29.1 5.000 5.000 8.02
FEF25-75 L/SEC 4.478 4._.500 100.5 4._.000 15.000 2.81
MVV L/MIN 211.72 3.00 1.4 4.00 10.00 163.87
FEV1/FVC % 51

AFTER INHALATION CHALLENGE 6/6/02 5/31/02
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(NOTES): AFTER INHALATION

Wawh-N
o
o
o

N WO
o
o

-000

8.00
7.00
6.000
5.000
4.00

6/6/02
8.00
7.00
6.000

9.00

8.00

7.000
10.000
50.00

4.94
8.02
2.81
3.

163.87

5/31/02

9.90
8.00
7.000

4.94
8.02

DEFFUSEON . L L i i i e e e e e e e e e e e

FvC L 7.76
FEV1 L 5.79
PF L/SEC 10.986
FEF25-75 L/SEC 4.478
MVV L/MIN 211.72
FEV1/FVC %

AFTER EXERCISE
FvC L 7.76
FEV1 L 5.79
PF L/SEC 10.986
FEV1/FVC %

METHOD: STEADY STATE

DLCO-SB L 37.16

Corr DLCO for HB & COHB: 37.16

6/30/03
45.00

6/6/02
50.00

29.

BLOOD GASES . - - o o i i e o e e e e e e e e e e e e e e e e e e e e e

STUDY TYPE pH  pCO2 p02

(NORMAL)  7.36-7.44 36-44 80-100

100% 02 STUDY 7.000 0.0 0.0
PATIENT TEMPERATURE (C): 35

MAX EXERCISE 8.000 44.0 3.0
PATIENT TEMPERATURE (C): 30
(NOTES): TEST QS

SUPPLEMENTAL  8.000 9.0 0.0

PATIENT TEMPERATURE (C): 32

POST EXERCISE 7.456 99.0 345.0
PATIENT TEMPERATURE (C): 33
(NOTES): TEST QS

UNITS

02HB
>88%
4_.0%

COHB MHB
<3% <2%
0.0% 0.0%

53.0% 33.0%23.0%

67.0%  0.0%56.0%

78_.0% 45.0%45._0%

ACTUAL

HB Fi02
3.0 0.500

15.4 0.343

0.0 0.900

15.1 1.000

A-a02
<22
277

132

486

84

PREV2

QS/QT

SPECHIAL STUDIES . .« .« i i i e e d e e e e e e e e e

MAXIMUM PRESSURES

(NOTES): 44

PiMAX cmH20
MECHANICS

Raw cmH20/L/S
SGaw L/S/cmH20
Cst 4cmH20
SMALL AIRWAY

Cdyn L/cmH20
FEF50 He-Air L/Sec
VISOV L

cv L

Ccv/VvC %

CV/TLC %
VISOV/CV %
EXERCISE

(NOTES) : fgdgrdgtdgd

.00
.30
.50

[eNeRFN

OFRLNOWOL O
o
o

6/30/03

99.00

6/30/03

15.00
0.30
1.00

6/30/03
1.00

45.00
5.00
4.00

6/30/03

6/6/02

68.00

6/6/02

10.00
0.20
0.40

6/6/02
0.45

56.00
5.00
5.00

6/6/02

April 2004

Clinical Procedures V. 1.0
User Manual

5-5




Viewing the Reports

VEmax(BTPS) L 44 .00

BR L 34.00
VD/VT MAX L 0.70
VErest(BTPS) ml/beat 3.00
EKG ABNORMAL
Wmax wrpm/min 2.00
WRI/WRT watts/min 3.00
Max Speed mph 15.00
TOTAL TIME  min 100.00

Exercise Testing Mode: BIKE ERGOMETER

REASON(S) FOR STOPPIN

INTERPRETATION:

G:

90.00 90.00
50.00 50.00

0.43
35.00 30.00
100.00 245.00
35.00 40.00
20.00 15.00
100.00 600.00

Patient cannot work on Bike Treadmill anymore.
he will work on something different such as a

Cardioglider.

COMMENTS AND RECOMMENDATIONS:
INTERPRETED BY:
SMITH, JOE
PREDICTED VALUE FORMULAS USED
TLC .078*HT-7.3 BOREN & KORY "66
VC -06*HT-(-0214*AGE)-4.65 CRAPO "81
FRC .032*HT-2.94 BOREN & KOREY "66
RV -019*HT+(.0115*AGE)-2.24 BOREN & KORY "66
FvC -06*HT-(.0214*AGE)-4.65 CRAPO "81
FEV1 -0414*HT-(.0244*AGE)-2.190 CRAPO "81
PF 3.9*HT-(3*AGE)-49.36/60 FERRIS "64
FEF25-75 -0204*HT-(.038*AGE)+2.133 CRAPO "81
MVV 1.356*HT-(1.26*AGE)-21.4 BOREN & KOREY "66
DLCO-SB 12.9113-(.229*AGE)+(.1672*HT) MILLER "83
COHB CORR. ACT*(1+(COHB/100)) MORRIS "85
HB CORR. HB+10.22/(1.7*HB)*ACT COTES "72
NOTE: HT=height,WT=weight,ACT=actual measurement value
Fhx END FFAFAIIA XA AA X CONFIDENTIAL SUMMARY pg- 1
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Brief Report

This report lists all procedures (Medicine and CP) that fall within a specified date range and the
maximum number of occurrences (Max/site). The name of the report, selected date range and
maximum number of occurrences (Max/site) appear above the report. These procedures are
listed according to Consult Number, Completed Procedures, Date/Time Performed and
Procedure Code (also known as Procedure Summary Code).

Medicine/CP Brief Report [From: May 4,2003 to May 3,2004] Max/site: 10

Printed for data from 05/04/2003 to 05/03/2004 05/03/2004 13:22
““““““““““ CONFIDENTIAL SUMMARY pg- 1 falaialale
TEST,PATIENT 125-43-2111 3AS DOB: 02/03/1943

——————————————————————————— MEDB - Med Brief Report --—-———————— -~

CONSULT DATE/TIME
NUMBER COMPLETED PROCEDURES PERFORMED PROCEDURE CODE

COLONOSCOPY APR 16,2004@15:38 ABNORMAL
PULMONARY FUNCTION TEST MAR 30,2004@13:43
PULMONARY FUNCTION TEST MAR 16,2004@13:40 ABNORMAL
ELECTROPHYSIOLOGY JUN 30,2003@10:40 ABNORMAL
PULMONARY FUNCTION TEST JUN 30,2003@09:37 NORMAL

FHhE END ARk CONFIDENTIAL SUMMARY pg- 1 Fekderk
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Full Captioned

This report shows all Medicine and CP reports within a specified date range and the maximum
number of occurrences (Max/site). The name of the report, selected date range and maximum
number of occurrences (Max/site) appear above the report. Fields that do not contain data
within the Medicine reports do not display.

Medicine/CP Full Captioned [From: May 20,2003 to May 19,2004] Max/site: 10

Printed for data from 05/20/2003 to 05/19/2004 05/19/2004 14:54
""""""""""" CONFIDENTIAL SUMMARY pg- 1
TEST,PATIENT 125-43-2111 3AS DOB: 02/03/1943

APPOINTMENT DATE/TIME: 4/16/04@15:38
MEDICAL PATIENT: TEST,PATIENT
PROTOCOL : STOMACH TEST

EGD SIMPLE PRIMARY EXAM: Y

LAB OR XRAY: LAB

INDICATION COMMENT: TESTING

LOCATION EVALUATED:
COLON ASCENDING
GROSS: ABSENCE
SUMMARY : ABNORMAL
PROCEDURE SUMMARY : TESTING THE PROCEDURE

INSTRUMENT:

SCOPE 1
ENDOSCOPIST: DEMO,CP
WARD/CLINIC: Gl LAB
TIME STARTED: 0600
TIME COMPLETED: 1000
URGENCY OF PROCEDURE: ELECTIVE
PREPARATION DIET: CLEAR LIQUIDS
ENEMAS: PHOSPHASODA

PULMONARY FUNCTION TEST MAR 30,2004@13:43
SEX: M AGE: 61 85 in/167 1b AMBIENT: 35C/600T
RACE: WHITE, NOT OF HISPANIC ORIGIN TECH: SMITH,JOE
NON-SMOKER CURRENT BRONCHODILATOR USE EFFORT: GOOD
CONSULT DX:
COUGH
UNITS PRED ACTUAL %PRED PREV1 PREV2 Cl
VOLUMES - - - o it e i e e e e e e e e e ccaccccaceacccaacaaaaeaaaa e e
BODY BOX 3/16/04 6/30/03
TLC L 9.54 2.00 21.0 3.00 7.00 8.10
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VC L 7.00 3.00 42.9 2.00 6.00
FRC L 3.97 4.00 100.8 4.00 4.00 U 5.01
RV L 2.56 5.00 195.0 5.00 2.00 U 3.44
RV/TLC % 250
INTERPRETATION:
COMMENTS AND RECOMMENDATIONS:
INTERPRETED BY:
PREDICTED VALUE FORMULAS USED
TLC .078*HT-7.3 BOREN & KORY <66
VC .06*HT-(.0214*AGE)-4.65 CRAPO "81
FRC .032*HT-2.94 BOREN & KOREY "66
RV .019*HT+(.0115*AGE)-2.24 BOREN & KORY <66
FvC -06*HT-(-0214*AGE)-4.65 CRAPO *"81
FEV1 .0414*HT-(.0244*AGE)-2.190 CRAPO "81
PF 3.9*HT-(3*AGE)-49.36/60 FERRIS "64
FEF25-75 -0204*HT-(.038*AGE)+2.133 CRAPO "81
MVV 1.356*HT-(1.26*AGE)-21.4 BOREN & KOREY "66
DLCO-SB 12.9113-(.229*AGE)+(.1672*HT) MILLER "83
COHB CORR. ACT*(1+(COHB/100)) MORRIS "85
HB CORR. HB+10.22/(1.7*HB)*ACT COTES "72
NOTE: HT=height,WT=weight,ACT=actual measurement value
PULMONARY FUNCTION TEST MAR 16,2004@13:40 ABNORMAL

SEX: M AGE: 61 90 in/160
RACE: WHITE, NOT OF HISPANIC ORIGIN

Ib AMBIENT: 35C/600T

TECH: SMITH,JOE

SMOKER CURRENT BRONCHODILATOR USE EFFORT: GOOD
CONSULT DX:
COUGH
ASTHMA
INTERSTITIAL LUNG DISEASE
UNITS PRED ACTUAL %PRED PREV1 PREV2 Cl
VOLUMES . | i e e e e e e e e e e
INERT GAS DILUTION 6/30/03 6/6/02
(NOTES): TEST INERT GAS
TLC L 10.53 9.00 85.5 5.00 8.00 9.09
VC L 7.76 3.00 38.7 7.00 7.00
FRC L 4.38 4.00 91.4 3.00 6.50 U 5.42
RV L 2.80 5.00 178.3 4.00 4.00 U 3.68
RV/TLC % 56
BODY BOX 6/30/03 6/6/02
(NOTES): TEST BODY BOX
TLC L 10.53 3.00 28.5 7.00 9.90 9.09
vC L 7.76 2.00 25.8 6.00 7.00
FRC L 4.38 4.00 91.4 4.00 6.00 U 5.42
RV L 2.80 5.00 178.3 2.00 5.00 U 3.68
RV/TLC % 167
NITROGEN WASH OUT 6/6/02 5/31/02

(NOTES): TEST NITROGEN WASH OUT
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TLC L 10.53 7.00 66.5 6.00 7.00 9.09
VC L 7.76 4._.00 51.5 5.50 6.00
FRC L 4_.38 3.00 68.6 4_.00 4_.00 5.42
RV L 2.80 2.00 71.3 3.00 3.00 3.68
RV/TLC % 29
X-RAY PLANIMETRY 6/6/02 5/30/02
(NOTES): TEST X-RAY
TLC L 10.53 5.00 47.5 7.00 9.00 9.09
VC L 7.76 4.00 51.5 6.40 6.00
FRC L 4._.38 7.00 160.0 3.00 4.00 5.42
RV L 2.80 8.00 285.2 1.00 5.00 3.68
RV/TLC % 160
UNITS PRED ACTUAL %PRED PREV1 PREV2 Cl
L 0
MACHINE: FLOW TURBINE
STANDARD STUDY 6/6/02 5/30/02
(NOTES): TEST STANDARD
FVvC L 7.76 4_.30 55.4 8.00 9.00
FEV1 L 5.79 2.20 38.0 6.00 4_.00 4.94
PF L/SEC 10.986 3.200 29.1 5.000 5.000 8.02
FEF25-75 L/SEC 4.478 4.500 100.5 4_.000 15.000 2.81
MVV L/MIN 211.72 3.00 1.4 4.00 10.00 163.87
FEV1/FVC % 51
AFTER INHALATION CHALLENGE 6/6/02 5/31/02
(NOTES): AFTER INHALATION
FVC L 7.76 7.00 90.2 8.00 9.00
FEV1 L 5.79 4._.00 69.1 7.00 8.00 4.94
PF L/SEC 10.986 3.000 27.3 6.000 7.000 8.02
FEF25-75 L/SEC 4.478 5.000 111.6 5.000 10.000 2.81
MVV L/MIN 211.72 3.00 1.4 4.00 50.00 163.87
FEV1/FVC % 57
AFTER EXERCISE 6/6/02 5/31/02
FvC L 7.76 5.00 64.4 8.00 9.90
FEV1 L 5.79 3.00 51.9 7.00 8.00 4.94
PF L/SEC 10.986 2.000 18.2 6.000 7.000 8.02
FEV1/FVC % 60
DIFFUSHEON .« L it et e i e i e e e e e e e aee e e aaaaccaee e ae e e aa e e
METHOD: STEADY STATE
6/30/03 6/6/02
DLCO-SB L 37.16 33.00 88.8 45.00 50.00 29.18
Corr DLCO for HB & COHB: 37.16 32.55 87.6
BLOOD GASES . .« o oo e e e e e e e e e e e e e e e e e e e e e e aaaaaa
STUDY TYPE pH pCO02 pO02 02HB COHB MHB HB Fi0o2 A-a02 QS/QT
(NORMAL) 7.36-7.44 36-44 80-100 >88% <3% <2% <22
100% 02 STUDY 7.000 0.0 0.0 4_0% 0.0% 0.0% 3.0 0.500 277
PATIENT TEMPERATURE (C): 35
MAX EXERCISE 8.000 44.0 3.0 53.0% 33.0%23.0% 15.4 0.343 132
PATIENT TEMPERATURE (C): 30
(NOTES): TEST QS
SUPPLEMENTAL 8.000 9.0 0.0 67.0% 0.0%56 - 0% 0.0 0.900 486
PATIENT TEMPERATURE (C): 32
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POST EXERCISE 7.456 99.0 345.0 78.0% 45.0%45.0% 15.1 1.000 84 0.52
PATIENT TEMPERATURE (C): 33
(NOTES): TEST QS

UNITS ACTUAL PREV1 PREV2
SPECHAL STUDIES . | o e e e

MAXIMUM PRESSURES 6/30/03 6/6/02
(NOTES): 44
PiMAX cmH20 5.00 99.00 68.00
MECHANICS 6/30/03 6/6/02
Raw cmH20/L/S 4.00 15.00 10.00
SGaw L/S/cmH20 0.30 0.30 0.20
Cst 4cmH20 0.50 1.00 0.40
SMALL AIRWAY 6/30/03 6/6/02
Cdyn L/cmH20 0.40 1.00 0.45
FEF50 He-Air L/Sec 45.00 45.00 56.00
VISOV L 3.00 5.00 5.00
Ccv L 5.00 4.00 5.00
Cv/vC % 2.50
CV/TLC % 1.67
VISOv/CcV % 0.60
EXERCISE 6/30/03 6/6/02
(NOTES) : fgdgrdgtdgd
VEmax(BTPS) L 44 .00 90.00 90.00
BR L 34.00 50.00 50.00
VD/VT MAX L 0.70 0.43
VErest(BTPS) ml/beat 3.00 35.00 30.00
EKG ABNORMAL
Wmax wrpm/min 2.00 100.00 245.00
WRI/ZWRT watts/min 3.00 35.00 40.00
Max Speed mph 15.00 20.00 15.00
TOTAL TIME  min 100.00 100.00 600.00

Exercise Testing Mode: BIKE ERGOMETER

REASON(S) FOR STOPPING:
Patient cannot work on Bike Treadmill anymore.
he will work on something different such as a
Cardioglider.

INTERPRETATION:
COMMENTS AND RECOMMENDATIONS:

INTERPRETED BY:
SMITH, JOE

PREDICTED VALUE FORMULAS USED

TLC .078*HT-7.3 BOREN & KORY "66
VC -06*HT-(.0214*AGE)-4.65 CRAPO "81

FRC -032*HT-2.94 BOREN & KOREY "66
RV -019*HT+(.0115*AGE)-2.24 BOREN & KORY "66
FVvC .06*HT-(.0214*AGE)-4.65 CRAPO =81

FEV1 -0414*HT-(.0244*AGE)-2.190 CRAPO "81

PF 3.9*HT-(3*AGE)-49.36/60 FERRIS "64

FEF25-75 -0204*HT-(.038*AGE)+2.133 CRAPO "81
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NOTE:

*x*k

MVV 1.356*HT-(1.26*AGE)-21.4 BOREN & KOREY "66

DLCO-SB 12.9113-(-229*AGE)+(-1672*HT) MILLER =83

COHB CORR. ACT*(1+(COHB/100)) MORRIS "85

HB CORR. HB+10.22/(1.7*HB)*ACT COTES "72
HT=height,WT=weight,ACT=actual measurement value

END Fastddsdadstaxx* CONFIDENTIAL SUMMARY
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Full Report

This report shows all Medicine and CP reports within a specified date range and the maximum
number of occurrences (Max/site). The name of the report, selected date range and maximum
number of occurrences (Max/site) appear above the report. All data fields, including null values,
are displayed.

Medicine/CP Full Report [From: May 20,2003 to May 19,2004] Max/site: 10

Printed for data from 05/20/2003 to 05/19/2004 05/19/2004 13:25
""""""""""" CONFIDENTIAL SUMMARY pg- 1
TEST,PATIENT 125-43-2111 3AS DOB: 02/03/1943

APPOINTMENT DATE/TIME: 4/16/04@15:38
MEDICAL PATIENT: TEST,PATIENT
PROTOCOL : STOMACH TEST

EGD SIMPLE PRIMARY EXAM: Y

LAB OR XRAY: LAB

OCCULT BLOOD:

SPECIMEN COLLECTION:

INDICATION COMMENT: TESTING

LOCATION EVALUATED:
COLON ASCENDING
GROSS: ABSENCE
MEASUREMENT :
IMPRESSION:
FELLOW:
SUMMARY : ABNORMAL
PRIMARY DIAGNOSIS:
PROCEDURE SUMMARY : TESTING THE PROCEDURE

INSTRUMENT :
SCOPE 1
ENDOSCOPIST: DEMO, CP
WHERE PERFORMED:
WARD/CLINIC: Gl LAB
TIME STARTED: 0600
TIME COMPLETED: 1000
URGENCY OF PROCEDURE: ELECTIVE
PREPARATION DIET: CLEAR LIQUIDS
DIET COMMENT:
ENEMAS: PHOSPHASODA
COMMON BILE DUCT SIZE (mm):
PANCREATIC DUCT SIZE (mm):
DEPTH OF INSERTION:
POST-PROC INSTRUMENT CLEANSING:
SECOND FELLOW:

INSTRUCTIONS TO PATIENT:

PULMONARY FUNCTION TEST MAR 30,2004@13:43
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SEX: M AGE: 61 85 in/167 1b AMBIENT: 35C/600T
RACE: WHITE, NOT OF HISPANIC ORIGIN TECH: JACKSON, SARAH
NON-SMOKER CURRENT BRONCHODILATOR USE EFFORT: GOOD
CONSULT DX:
COUGH
UNITS PRED ACTUAL %PRED PREV1 PREV2 Cl
VOLUMES . i e e e e e e e e e e e
BODY BOX 3/16/04 6/30/03
TLC L 9.54 2.00 21.0 3.00 7.00 8.10
VvC L 7.00 3.00 42.9 2.00 6.00
FRC L 3.97 4.00 100.8 4.00 4.00 U 5.01
RV L 2.56 5.00 195.0 5.00 2.00 U 3.44
RV/TLC % 250
INTERPRETATION:

COMMENTS AND RECOMMENDATIONS:

INTERPRETED BY:

PREDICTED VALUE FORMULAS USED

TLC .078*HT-7.3 BOREN & KORY "66
VC -06*HT-(.0214*AGE)-4.65 CRAPO "81
FRC -032*HT-2.94 BOREN & KOREY "66
RV -019*HT+(.0115*AGE)-2.24 BOREN & KORY "66
FVvC .06*HT-(.0214*AGE)-4.65 CRAPO =81
FEV1 -0414*HT-(.0244*AGE)-2.190 CRAPO "81
PF 3.9*HT-(3*AGE)-49.36/60 FERRIS "64
FEF25-75 -0204*HT-(.038*AGE)+2.133 CRAPO "81
MVV 1.356*HT-(1.26*AGE)-21.4 BOREN & KOREY "66
DLCO-SB 12.9113-(-229*AGE)+(-1672*HT) MILLER "83
COHB CORR. ACT*(1+(COHB/100)) MORRIS "85
HB CORR. HB+10.22/(1.7*HB)*ACT COTES "72
NOTE: HT=height,WT=weight,ACT=actual measurement value
PULMONARY FUNCTION TEST MAR 16,2004@13:40 ABNORMAL
SEX: M AGE: 61 90 in/160 1Ib AMBIENT: 35C/600T
RACE: WHITE, NOT OF HISPANIC ORIGIN TECH: SMITH,JOE
SMOKER CURRENT BRONCHODILATOR USE EFFORT: GOOD
CONSULT DX:
COUGH
ASTHMA
INTERSTITIAL LUNG DISEASE
UNITS PRED ACTUAL %PRED PREV1 PREV2 Cl
VOLUMES . - o ot it e e e it it e e e e e aeaac e e e aaeaa e e e e e e
INERT GAS DILUTION 6/30/03 6/6/02

(NOTES): TEST INERT GAS
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TLC
vC
FRC
RV
RV/TLC %

|

S

BODY BOX

(NOTES): TEST BODY BOX
TLC
VC
FRC
RV
RV/TLC %

rrrrr

NITROGEN WASH OUT

10.53
7.76
4.38
2.80

10.53
7.76
4.38
2.80

(NOTES): TEST NITROGEN WASH OUT

TLC L
VC L
FRC L
RV L
RV/TLC %

X-RAY PLANIMETRY
(NOTES): TEST X-RAY

TLC L
VvC L
FRC L
RV L
RV/TLC %

UNITS

MACHINE: FLOW TURBINE

STANDARD STUDY

10.53
7.76
4.38
2.80

10.53
7.76
4.38
2.80

PRED

(NOTES): TEST STANDARD

FvC L
FEV1 L
PF L/SEC
FEF25-75 L/SEC
MVV L/MIN

FEV1/FVC %

7.76

5.79
10.986

4.478
211.72

INHALATION CHALLENGE

7.76
5.79
10.986

4.478

AFTER
(NOTES): AFTER INHALATION
FvC L
FEV1 L
PF L/SEC
FEF25-75 L/SEC
MVV L/MIN

FEV1/FVC %

AFTER EXERCISE

FvC L
FEV1 L
PF L/SEC

FEV1/FVC %

211.72

7.76
5.79
10.986

9.00 85.5
3.00 38.7
4.00 91.4
5.00 178.3
56
3.00 28.5
2.00 25.8
4._00 91.4
5.00 178.3
167
7.00 66.5
4.00 51.5
3.00 68.6
2.00 71.3
29
5.00 47.5
4.00 51.5
7.00 160.0
8.00 285.2
160
ACTUAL %PRED
4.30 55.4
2.20 38.0
3.200 29.1
4_.500 100.5
3.00 1.4
51
7.00 90.2
4.00 69.1
3.000 27.3
5.000 111.6
3.00 1.4
57
5.00 64.4
3.00 51.9
2.000 18.2
60

6/6/02

8.00
6.00
5.000
4_.000
4.00

6/6/02

8.00
7.00
6.000
5.000
4.00

6/6/02
8.00
7.00
6.000

DEFFUSHEON - L L i i i e i e e e e e e e e e e e

METHOD: STEADY STATE

6/30/03

8.00 9.09
7.00

6.50 U 5.42
4.00 U 3.68
6/6/02

9.90 9.09
7.00

6.00 U 5.42
5.00 U 3.68
5/31/02

7.00 9.09
6.00

4.00 U 5.42
3.00 U 3.68
5/30/02

9.00 9.09
6.00

4.00 U 5.42
5.00 U 3.68
PREV2 CI
5/30/02

9.00

4_00 4.94
5.000 8.02
15.000 2.81
10.00 163.87
5/31/02

9.00

8.00 4.94
7.000 8.02
10.000 2.81
50.00 163.87
5/31/02

9.90

8.00 4.94
7.000 8.02
6/6/02
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Corr DLCO for HB & COHB: 37.16

BLOOD GASES

STUDY TYPE
(NORMAL) 7.36-7.44 36-44 80-100
100% 02 STUDY 7.000

DLCO-SB L 37

pH pCO2

0.0

PATIENT TEMPERATURE (C): 35

MAX EXERCISE

8.000 44.0

PATIENT TEMPERATURE (C): 30
(NOTES): TEST QS

SUPPLEMENTAL

8.000 9.0

PATIENT TEMPERATURE (C): 32

POST EXERCISE 7.456 99.0 345.0

PATIENT TEMPERATURE (C): 33
(NOTES): TEST QS

SPECIAL STUDIES

UNITS

MAXIMUM PRESSURES

(NOTES): 44

PiMAX cmH20
MECHANICS

Raw cmH20/L/S
SGaw L/S/cmH20
Cst 4cmH20
SMALL AIRWAY

Cdyn L/cmH20
FEF50 He-Air L/Sec
VISOV L

cv L

cv/VvC %

CV/TLC %
VISOV/CV %
EXERCISE

(NOTES) : fgdgrdgtdgd

VEmax(BTPS) L

BR L

VD/VT MAX L
VErest(BTPS) ml/beat
EKG

Wmax wrpm/min
WRI/WRT watts/min
Max Speed mph
TOTAL TIME  min

50.00

<22

84

PREV2

6/6/02
68.00

6/6/02

10.00
0.20
0.40

6/6/02
0.45

56.00
5.00
5.00

6/6/02

90.00
50.00

0.43
30.00

245.00
40.00
15.00

.16 33.00 88.8 45.00
32.55 87.6
p02 02HB  COHB MHB HB
>88% <3% <2%
0.0 4.0% 0.0% 0.0% 3.0 0.500 277
3.0 53.0% 33.0%23.0% 15.4 0.343 132
0.0 67.0% 0.0%56.0% 0.0 0.900 486
78_.0% 45.0%45.0% 15.1 1.000
ACTUAL PREV1
6/30/03
5.00 99.00
6/30/03
4.00 15.00
0.30 0.30
0.50 1.00
6/30/03
0.40 1.00
45.00 45.00
3.00 5.00
5.00 4._00
2.50
1.67
0.60
6/30/03
44.00 90.00
34.00 50.00
0.70
3.00 35.00
ABNORMAL
2.00 100.00
3.00 35.00
15.00 20.00
100.00 100.00

Exercise Testing Mode: BIKE ERGOMETER
REASON(S) FOR STOPPING:

INTERPRETATION:

600.00

29.18

Fi02 A-a02 QS/QT

Patient cannot work on Bike Treadmill anymore.
he will work on something different such as a
Cardioglider.
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COMMENTS AND RECOMMENDATIONS:

INTERPRETED BY:
SMITH, JOE

PREDICTED VALUE FORMULAS USED

TLC .078*HT-7.3 BOREN & KORY <66
VC .06*HT-(.0214*AGE)-4.65 CRAPO "81
FRC .032*HT-2.94 BOREN & KOREY "66
RV .019*HT+(.0115*AGE)-2.24 BOREN & KORY <66
FvC -06*HT-(-0214*AGE)-4.65 CRAPO "81
FEV1 .0414*HT-(.0244*AGE)-2.190 CRAPO "81
PF 3.9*HT-(3*AGE)-49.36/60 FERRIS "64
FEF25-75 .0204*HT-(.038*AGE)+2.133 CRAPO "81
MVV 1.356*HT-(1.26*AGE)-21.4 BOREN & KOREY "66
DLCO-SB 12.9113-(.229*AGE)+(.1672*HT) MILLER "83
COHB CORR. ACT*(1+(COHB/100)) MORRIS "85
HB CORR. HB+10.22/(1.7*HB)*ACT COTES "72
NOTE: HT=height,WT=weight,ACT=actual measurement value
*** END CONFIDENTIAL SUMMARY pg. 1 FEFFEERRkkkkdkkkkk
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Procedures (local only)
This report component lists all Medicine and CP procedures for a selected patient in CPRS. The

Procedures (local only) list contains the following column elements: Procedure Date/Time,
Medicine Procedure Name, and Report Status (also known as the Procedure Summary Code).

Medicing/CF Procedures [local anly]

Frocedure Date/Time | Medicine Procedura Marme | Report Status | [+] |A
04/16/2004 1538 COLAMOSCORY ABNORMAL [+]
03/30/2004 13:43 PULMOMARY FUMCTION TEST [+]
03/1642004 1340 PULMOMARY FUMCTION TEST ABMORMAL [+]
07/2342003 03:.00 BRONC wW/BROMC WASHING MNORMAL [+]
0E/30/2003 10:40 ELECTROPHYSIOLOGY ABMORMAL [+]
MR S0 2900 1937 P KACTR ARS FLIMCTION TECT (Al=1%EY Fal i

The Procedure Date/Time column lists the procedures in chronological order. Both the Medicine
and CP procedures are listed together. After you select the procedure that you want to view, the
report is displayed in the lower-right portion of your screen. If you see an interpretation (T1U
document), then you are viewing a CP procedure, otherwise you are viewing a Medicine
procedure.

Here is an example of a CP Report.

Pg. 1 HINES VAMC
SPIROMETRY, PRE and POST
TEST,PATIENT 125-43-2111 DOB: FEB 3,1943 (61) 3AS

TITLE: HISTORICAL PROCEDURE REPORT

DATE OF NOTE: JUL 03, 2003@13:46 ENTRY DATE: JUL 03, 2003@13:46:22
AUTHOR: JACKSON, SARAH EXP COSIGNER:
URGENCY: STATUS: COMPLETED

PROCEDURE SUMMARY CODE: Abnormal
DATE/TIME PERFORMED: JUL 03, 2003@13:45

TEST

/es/ SARAH JACKSON
MEDICAL SPECIALIST
Signed: 03/12/2004 11:04

TITLE: PFT
DATE OF NOTE: JUL 03, 2003@13:53 ENTRY DATE: JUL 03, 2003@13:53
AUTHOR: EXP COSIGNER:
URGENCY: STATUS: UNDICTATED

PROCEDURE SUMMARY CODE:
DATE/TIME PERFORMED: JUL 03, 2003@13:45
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TITLE: PFT
DATE OF NOTE: JUL 03, 2003@14:34:32 ENTRY DATE: JUL 03, 2003@14:34:32
AUTHOR: EXP COSIGNER:
URGENCY: STATUS: UNDICTATED

PROCEDURE SUMMARY CODE:
DATE/TIME PERFORMED: JUL 03, 2003@13:45

NOTE: Images are associated with this procedure.
Please use Imaging Display to view the images.
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Here is an example of a Medicine Report.

Pg. 1 HINES VAMC 05703704 13:30
ELECTROPHYSIOLOGY REPORT - RELEASED ON-LINE VERIFIED

TEST,PATIENT 125-43-2111 DOB: FEB 3,1943 (61) 3AS

DATE/TIME: 6/30/03@10:40

MEDICAL PATIENT: TEST,PATIENT
WARD/CLINIC: CARDIAC CLINIC
CARDIAC DX: AORTIC STENOSIS
REASON FOR STUDY: AGINA PROBLEMS.

SYMPTOM:
UNSTABLE ANGINA

RISK FACTOR:
CARDIOMEGALY (X-RAY)

ARRHYTHMIA DX:
HEART BLOCK-MOBITZ 11

HX :
This i1s the HX text.

Report Release Status

Current Date Person Who
Report Status Last Changed Date of Report
Status Changed The Status Entry Version
RELEASED ON-LINE VERIFIED
6/30/03 NA JACKSONS 6/30/03 lofl
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Procedures

This report component lists Medicine and CP procedures for a selected patient visiting your
facility, who is typically seen at another facility. You can view a patient’s data from a remote
facility, which is called remote data viewing.

Medicing/CF Procedures [From: Aug 12,2000 to kMay 18,2003] Mawx/zite:10

Frocedure Date/Time | Medicine Procedura Marme | Surnmary | Detailed Report
12/04/2002 09:00 BRONC W/BRONC WASHING Mo Summary :
09/10/2002 12:00 ECG Mo Summary

08/29/2002 11:08 ECHO Mo Summary Do
0741952002 1700 LAPARASCORY Mo Surnmary Pratocal ...

05/258/2002 14:00 PULMOMNARY PROCEDURES Mo Surnmary
05/258/2002 14:00 SPIROMETRY. PRE and POST Mo Surnmary
05/28/2002 14:00 SPIROMETRY. PRE and POST Mo Surnmary

The procedures are listed in chronological order within a specified date range and a maximum
number of occurrences (Max/site). The name of the report, selected date range and maximum
number of occurrences (Max/site) appear above the procedure list.

Procedure Date/Time
09/02/2003 16:30

Medicine Procedure Name
ECHO

Summary
No Summary

Detailed Report

TITLE: ECHO EXAM

DATE OF NOTE: MAR 05, 2002@08:53 ENTRY
DATE: MAR 05, 2002@08:53:14
AUTHOR: JACKSON, SARAH EXP COSIGNER:
URGENCY: STATUS:

COMPLETED

PROCEDURE SUMMARY CODE: Abnormal
DATE/TIME PERFORMED: MAR 04, 2002@12:21

test
/es/ TEST JACKSONS

MEDICAL SPECIALIST
Signed: 03/05/2002 12:06

TITLE: ECHO EXAM
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DATE OF NOTE: SEP 02, 2003@15:48:49 ENTRY
DATE: SEP 02, 2003@15:48:49

AUTHOR: EXP COSIGNER:
URGENCY: STATUS:
UNDICTATED

PROCEDURE SUMMARY CODE:
DATE/TIME PERFORMED: SEP 02, 2003@16:30

Facility: SUPPORT ISC
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Configuring the Medicine Report to Display in CPRS

The Medicine View file (#690.2) controls which fields are displayed in the Medicine reports.
You can add and delete fields in the procedure type view template, which is located in the
Medicine View file. When you edit the template, the Medicine reports within the Procedures
(local only), Medicine/CP tree listing and the Health Summary reports are affected.

If the report does not display, be sure the procedure that you want to display is entered in the
PROCEDURE field for the appropriate template.

You can use FileMan to add fields to the Medicine View file. The following are examples of
adding a multiple field and a single field to a print template.

e Here is an example of how to add field #37.1, which is a sub-file (multiple field) to the
Full GI Medicine View entry.

VA FileMan 22.0

Select OPTION: 1 ENTER OR EDIT FILE ENTRIES

INPUT TO WHAT FILE: HEALTH SUMMARY COMPONENT// 690.2 MEDICINE VIEW
(36 entries)
EDIT WHICH FIELD: ALL// <RET>

Select MEDICINE VIEW PRINT VIEW TEMPLATE NAME: Full GI
ENDOSCOPY/CONSULT
PRINT VIEW TEMPLATE NAME: Full G1// <RET>
PRIMARY FILE: ENDOSCOPY/CONSULT// <RET>
Select FIELD NUMBER: 203// <RET>

FIELD NUMBER: 203// <RET>

ORDER ENTRY USAGE: UNKNOWN// <RET>

ASTM: <RET>

VALUE TYPE: <RET>

UNITS: <RET>

RANGES: <RET>

SEG: <RET>

PIECE: <RET>

CODING METHOD: <RET>
Select FIELD NUMBER: 37.1

Are you adding "37.1" as a new FIELD NUMBER (the 46TH for this MEDICINE
VIEW)? No// vy (Yes)

FIELD NUMBER ASTM: <RET>

ORDER ENTRY USAGE: <RET>

ASTM: <RET>

VALUE TYPE: <RET>

UNITS: <RET>

RANGES: <RET>

SEG: <RET>
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PIECE: <RET>

CODING METHOD: <RET>
Select FIELD NUMBER: <RET>

Select SUB-FILE: 699.19// <RET>

SUB-FILE: 699.19// <RET>

Select SUB-FIELD: .01// <RET>

SUB-FIELD: .01// <RET>
ORDER ENTRY USAGE: <RET>

ASTM: <RET>
VALUE TYPE: <RET>
UNITS: <RET>
RANGES: <RET>
SEG: <RET>

PIECE: <RET>
CODING: <RET>

Select SUB-FIELD: <RET>
Select SUB-FILE: 699.04

Are you adding "699.04" as a new SUB-FILE (the 23RD for this MEDICINE

VIEW)? No// Y (Yes)

Select SUB-FIELD: .01

Are you adding ".01" as a new SUB-FIELD (the 1ST for this SUB-FILE)? No// Y

(Yes)

SUB-FIELD ASTM: <RET>
ORDER ENTRY USAGE: <RET>

ASTM: <RET>
VALUE TYPE: <RET>
UNITS: <RET>
RANGES: <RET>
SEG: <RET>

PIECE: <RET>
CODING: <RET>

Select SUB-FIELD: <RET>

Select SUB-FILE: <RET>

Select PROCEDURE: GEN// ?
Answer with PROCEDURE

Choose from:
coL

EGD

ERC

GEN

GIENDO

LAP

LV PARAC
PARAC

VAS

You may enter a new PROCEDURE, if you wish

Answer with PROCEDURE/SUBSPECIALTY NAME, or GLOBAL LOCATION, or

TYPE OF PROCEDURE, or PRINT NAME

Do you want the entire 83-Entry PROCEDURE/SUBSPECIALTY List? N (No)
Select PROCEDURE: GEN// <RET>

Type: Full// <RET>

Select MEDICINE VIEW PRINT VIEW TEMPLATE NAME: <RET>
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e Here is an example of how to add a single field #204.5 to the Full GI Medicine View file
(#690.2).

Select MEDICINE VIEW PRINT VIEW TEMPLATE NAME: Full Gl
ENDOSCOPY/CONSULT
PRINT VIEW TEMPLATE NAME: Full GI1// <RET>
PRIMARY FILE: ENDOSCOPY/CONSULT// <RET>
Select FIELD NUMBER: 37.1// <RET>
FIELD NUMBER: 37.1// <RET>
ORDER ENTRY USAGE: <RET>
ASTM: <RET>
VALUE TYPE: <RET>
UNITS: <RET>
RANGES: <RET>
SEG: <RET>
PIECE: <RET>
CODING METHOD: <RET>
Select FIELD NUMBER: 204.5
Are you adding "204.5" as a new FIELD NUMBER (the 47TH for this MEDICINE
VIEW)? No// Y (Yes)
FIELD NUMBER ASTM: <RET>
ORDER ENTRY USAGE: <RET>
ASTM: <RET>
VALUE TYPE: <RET>
UNITS: <RET>
RANGES: <RET>
SEG: <RET>
PIECE: <RET>
CODING METHOD: <RET>
Select FIELD NUMBER: <RET>
Select SUB-FILE: 699.04// <RET>
SUB-FILE: 699.04// <RET>
Select SUB-FIELD: .01// <RET>
SUB-FIELD: .01// <RET>
ORDER ENTRY USAGE: <RET>
ASTM: <RET>
VALUE TYPE: <RET>
UNITS: <RET>
RANGES: <RET>
SEG: <RET>
PIECE: <RET>
CODING: <RET>
Select SUB-FIELD: <RET>
Select SUB-FILE: <RET>
Select PROCEDURE: GEN// <RET>
Type: Full// <RET>

Select MEDICINE VIEW PRINT VIEW TEMPLATE NAME: <RET>
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Access Code A unique sequence of characters known by and assigned only to the user, the
system manager and/or designated alternate(s). The access code (in conjunction with the
verify code) is used by the computer to identify authorized users.

Action A functional process that a clinician or clerk uses in the TIU computer program. For
example, “Edit” and “Search” are actions. Protocol is another name for Action.

ADP Coordinator/ADPAC/Application Coordinator Automated Data Processing Application
Coordinator. The person responsible for implementing a set of computer programs
(application package) developed to support a specific functional area such as clinical
procedures, PIMS, etc.

Application A system of computer programs and files that have been specifically developed to
meet the requirements of a user or group of users.

Archive The process of moving data to some other storage medium, usually a magnetic tape,
and deleting the information from active storage in order to free-up disk space on the system.

ASU Authorization/Subscription Utility, an application that allows sites to associate users with
user classes, allowing them to specify the level of authorization needed to sign or order
specific document types and orderables. ASU is distributed with TIU in this version;
eventually it will probably become independent, to be used by many VistA packages.

Attachments Attachments are files or images stored on a network share that can be linked to the
CP study. CP is able to accept data/final result report files from automated instruments. The file
types that can be used as attachments are the following:

ixt  Text files

a1tf - Rich text files

Jpg  JPEG Images

Jjpeg JPEG Images

.bmp Bitmap Images

tiff  TIFF Graphics (group 3 and group 4 compressed and uncompressed types)
.pdf  Portable Document Format

html  Hypertext Markup Language

.DOC (Microsoft Word files) are not supported. Be sure to convert .doc files to .rtf or to
.pdf format.

* Patch MD*1*2 July 2004 Chapter number changed from 5 to 6.
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Background Processing Simultaneous running of a "job" on a computer while working on
another job. Examples would be printing of a document while working on another, or the
software might do automatic saves while you are working on something else.

Backup Procedures The provisions made for the recovery of data files and program libraries
and for restart or replacement of ADP equipment after the occurrence of a system failure.

Boilerplate Text A pre-defined TIU template that can be filled in for Titles, Speeding up the
entry process. TIU exports several Titles with boilerplate text which can be modified to meet
specific needs; sites can also create their own.

Browse Lookup the file folder for a file that you would like to select and attach to the study.
(e.g., clicking the “...” button to start a lookup).

Bulletin A canned message that is automatically sent by MailMan to a user when something
happens to the database.

Business Rule Part of ASU, Business Rules authorize specific users or groups of users to
perform specified actions on documents in particular statuses (e.g., an unsigned TIU note
may be edited by a provider who is also the expected signer of the note).

Class Part of Document Definitions, Classes group documents. For example, “CLINICAL
PROCEDURES?” is a class with many kinds of Clinical Procedures notes under it. Classes
may be subdivided into other Classes or Document Classes. Besides grouping documents,
Classes also store behavior which is then inherited by lower level entries.

Consult Referral of a patient by the primary care physician to another hospital service/
specialty, to obtain a medical opinion based on patient evaluation and completion of any
procedures, modalities, or treatments the consulting specialist deems necessary to render a
medical opinion.

Contingency Plan A plan that assigns responsibility and defines procedures for use of the
backup/restart/recovery and emergency preparedness procedures selected for the computer
system based on risk analysis for that system.

CP Clinical Procedures.

CP Definition CP Definitions are procedures within Clinical Procedures.

°CP Procedure A procedure who’s data is stored in the Clinical Procedures package.

CP Study A CP study is a process created to link the procedure result from the medical device
or/and to link the attachments browsed from a network share to the procedure order.

® Patch MD*1*2 July 2004 New Glossary term added.
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CPRS Computerized Patient Record System. A comprehensive VistA program, which allows
clinicians and others to enter and view orders, Progress Notes and Discharge Summaries
(through a link with TIU), Problem List, view results, reports (including health summaries),
etc.

Data Dictionary A description of file structure and data elements within a file.
Device A hardware input/output component of a computer system (e.g., CRT, printer).

Document Class Document Classes are categories that group documents (Titles) with similar
characteristics together. For example, Cardiology notes might be a Document Class, with
Echo notes, ECG notes, etc. as Titles under it. Or maybe the Document Class would be
Endoscopy Notes, with Colonoscopy notes, etc. under that Document Class.

Document Definition Document Definition is a subset of TIU that provides the building blocks
for TIU, by organizing the elements of documents into a hierarchy structure. This structure
allows documents (Titles) to inherit characteristics (such as signature requirements and print
characteristics) of the higher levels, Class and Document Class. It also allows the creation
and use of boilerplate text and embedded objects.

Edit Used to change/modify data typically stored in a file.
Field A dataelementin a file.

File The M construct in which data is stored for retrieval at a later time. A computer record of
related information.

File Manager or FileMan Within this manual, FileManager or FileMan is a reference to VA
FileMan. FileMan is a set of M routines used to enter, edit, print, and sort/search related data
in a file, a database.

File Server A machine where shared software is stored.
Gateway The software that performs background processing for Clinical Procedures.

Global An M term used when referring to a file stored on a storage medium, usually a magnetic
disk.

GUI Graphical User Interface - a Windows-like screen that uses pull-down menus, icons,
pointer devices, and other metaphor-type elements that can make a computer program
more understandable, easier to use, allow multi-processing (more than one window or
process available at once), etc.
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Interpreter Interpreter is a user role exported with USR*1*19 to support the Clinical Procedures
Class. The role of the Interpreter is to interpret the results of a clinical procedure. Users who
are authorized to interpret the results of a clinical procedure are sent a notification when an
instrument report and/or images for a CP request are available for interpretation. Business
rules are used to determine what actions an interpreter can perform on a document of a
specified class, but the interpreter themselves are defined by the Consults application. These
individuals are “clinical update users’ for a given consult service.

IRMS Information Resource Management Service.

Kernel A set of software utilities. These utilities provide data processing support for the
application packages developed within the VA. They are also tools used in configuring the
local computer site to meet the particular needs of the hospital. The components of this
operating system include: MenuMan, TaskMan, Device Handler, Log-on/Security, and other
specialized routines.

LAYGO An acronym for Learn As You Go. A technique used by VA FileMan to acquire new
information as it goes about its normal procedure. It permits a user to add new data to a file.

M Formerly known as MUMPS or the Massachusetts (General Hospital) Utility Multi-
Programming System. This is the programming language used to write all VistA
applications.

MailMan An electronic mail, teleconferencing, and networking system.

®Medicine Procedure A procedure who’s data is stored in the Medicine package.

Menu A set of options or functions available to users for editing, formatting, generating reports,
etc.

Module A component of a software application that covers a single topic or a small section of a
broad topic.

Namespace A naming convention followed in the VA to identify various applications and to
avoid duplication. It is used as a prefix for all routines and globals used by the application.

Network Server Share A machine that is located on the network where shared files are stored.
Notebook This term refers to a GUI screen containing several tabs or pages.

Ol Office of Information, formerly known as Chief Information Office Field Office,
Information Resource Management Field Office, and Information Systems Center.

® patch MD*1*2 July 2004 New Glossary term added.
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Option A functionality that is invoked by the user. The information defined in the option is
used to drive the menu system. Options are created, associated with others on menus, or
given entry/exit actions.

Package Otherwise known as an application. A set of M routines, files, documentation and
installation procedures that support a specific function within VistA.

Page This term refers to a tab on a GUI screen or notebook.

Password A protected word or string of characters that identifies or authenticates a user, a
specific resource, or an access type (synonymous with Verify Code).

Pointer A special data type of VA FileMan that takes its value from another file. Thisis a
method of joining files together and avoiding duplication of information.

Procedure Request Any procedure (EKG, Stress Test, etc.) which may be ordered from another
service/specialty without first requiring formal consultation.

Program A set of M commands and arguments, created, stored, and retrieved as a single unit in
M.

Queuing The scheduling of a process/task to occur at a later time. Queuing is normally done if
a task uses up a lot of computer resources.

RAID Redundant Array of Inexpensive Drives. Imaging uses this to store images.

'Remote Data Viewing The act of viewing a patient’s data from a remote facility.

Result A consequence of an order. Refers to evaluation or status results. When you use the
Complete Request (CT) action on a consult or request, you are transferred to TIU to enter the
results.

<RET> Carriage return.

Routine A set of M commands and arguments, created, stored, and retrieved as a single unit in
M.

Security Key A function which unlocks specific options and makes them accessible to an
authorized user.

Sensitive Information Any information which requires a degree of protection and which should
be made available only to authorized users.

" Patch MD*1*2 July 2004 New Glossary term added.
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Site Configurable A term used to refer to features in the system that can be modified to meet the
needs of each site.

Software A generic term referring to a related set of computer programs. Generally, this refers
to an operating system that enables user programs to run.

Status Symbols Codes used in order entry and Consults displays to designate the status of the
order.

Task Manager or TaskMan A part of Kernel which allows programs or functions to begin at
specified times or when devices become available. See Queuing.

Title Titles are definitions for documents. They store the behavior of the documents which use
them.

TIU Text Integration Utilities.

User A person who enters and/or retrieves data in a system, usually utilizing a CRT.

User Class User Classes are the basic components of the User Class hierarchy of ASU
(Authorization/Subscription Utility) which allows sites to designate who is authorized to do

what to documents or other clinical entities.

User Role User Role identifies the role of the user with respect to the document in question
(e.g., Author/Dictator, Expected Signer, Expected Cosigner, Attending Physician, etc.).

Utility An M program that assists in the development and/or maintenance of a computer
system.

Verify Code A unique security code which serves as a second level of security access. Use of
this code is site specific; sometimes used interchangeably with a password.

VistA Veterans Health Information Systems and Technology Architecture.

Workstation A personal computer running the Windows 9x or NT operating system.
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